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END USER LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY: Below you will find the contractual
agreements governing the use of this imaging Software. These conditions
apply to you, the user, and to OLYMPUS SOFT IMAGING SOLUTIONS
GmbH. With any of the following actions you explicitly agree to be bound
by the conditions of this contract: purchasing the Software, opening the
package, breaking of one of the seals or using the Software.

In case you do not agree with any of the conditions of this contract,
please return all parts of the Software including manuals, the license
certificate and/or the Software protection key before using and without
delay. Remove all Software installations of the Software from any com-
puter you might have installed it on. Return all electronic media of the
Software or completely destroy all electronic media of the Software and
send proof that this has been accomplished. For a refund, please return
everything to where you purchased the Software.

1. Scope

(1) This License Agreement explicitly covers only the Software diskettes
or other media you received with the purchase and the Software stored
on these media, the manuals, the license certificate and/or the Software
protection key, together referred to as “Software”, as far as they were
developed and produced by OLYMPUS SOFT IMAGING SOLUTIONS
GmbH.

(2) The Software may be modified or enhanced by OLYMPUS SOFT
IMAGING SOLUTIONS GmbH or its licensors for debugging, upgrading
or any other purposes. The Software shall contain such modified or
enhanced version. You can only use either the previous version or the
modified or enhanced version and cannot use both of the versions. You
have, however, no right to receive modifications or enhancements or
upgrades, unless those are provided for warranty purposes and you have
a legitimate claim towards warranty.

(3) The Software may include (i) some open source software and (ii) other
third party software (collectively, "Third Party Software"). Regarding the
use of the Third Party Software, you shall follow the license terms and
conditions applied to such Third Party Software. Any part of this Agree-
ment does not restrict, change or alter any of your rights and obligations
imposed by the license terms and conditions of the Third Party Software.

2. User rights

(1) OLYMPUS SOFT IMAGING SOLUTIONS GmbH permits the User,
for the duration of this contract, to use the Software on a single computer
and a single terminal on that computer within the Territory of installation.
This license is explicitly non-exclusive, i.e., the User does not have an
exclusive right to use the Software. As a licensed user you can copy the
Software from one computer to another by using a computer network or
other storage devices, as long as it is assured, that the Software can only
be used on a single computer and terminal at any time and that the
conditions set forth under 4 are observed. For the purpose of this Li-
cense, the term Territory shall mean (i) for installations in a member state
of the European Union: all member states of the European Union and (ii)
for installations in a country outside of the European Union: the country in
which the computer is located on which the Software is installed.

(2) The User has the right to produce a copy of the Software only for
backup purposes.

(3) The Software is provided with a license certificate or a dongle. It is
the responsibility of the owner to take care of the license certificate and/or
of the dongle. In case of loss, neither the license certificate nor the dongle
will be replaced by OLYMPUS SOFT IMAGING SOLUTIONS GmbH.

3. Transfer

You may permanently transfer all of your rights under this Agreement only
if the recipient agrees to the terms and conditions of this Agreement and if
you destroy and will not keep any copies of the Software in your posses-
sion.

4. Copyright

(1) OLYMPUS SOFT IMAGING SOLUTIONS GmbH or its subsidiaries
remain owners of the copyright to the Software and its documentation.
With the purchase, the User obtains ownership of the diskettes or other
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physical storage devices (excluding the Software and other data con-
tained thereon), the manuals, and the license certificate and/or the
Software protection key. Furthermore, a right to use the Software as
defined in Sec. 2 will be granted.

(2) OLYMPUS SOFT IMAGING SOLUTIONS GmbH reserves the right
to all publications, duplication, editing, and marketing of the Software and
the Software documentation.

Without prior written permission the User may not:

« change, translate, de-compile or de-assemble the Software,

« copy any of the written or printed documentation of the Software,

« rent, lease, or license the Software to a third party,

« use the Software protection different than described in this contract.

(3) OLYMPUS SOFT IMAGING SOLUTIONS GmbH is the legal owner of
all copyrights and trademarks of the Software and documentation. Copy-
rights and trademarks are protected by national and international law.
OLYMPUS SOFT IMAGING SOLUTIONS GmbH reserves all rights,
which are not explicitly expressed in written form.

5. Warranty

(1) OLYMPUS SOFT IMAGING SOLUTIONS GmbH warrants that the
Software delivered under this Agreement for the period of 12 months of
the date of purchase works in all major aspects according to the descrip-
tions in the specification. OLYMPUS SOFT IMAGING SOLUTIONS
GmbH shall not be liable for the Software being suitable for a particular
purpose unless otherwise agreed upon to which you intend to put it.

(2) This warranty does not cover defects in the Software which are due
to improper installation or changes to the program which you have
undertaken.

(3) OLYMPUS SOFT IMAGING SOLUTIONS GmbH does not warrant,
that the Software is defect free, that the Software fulfills the specific
requirements of the User, or that the Software works with other Software
provided by the User.

(4) Where any claim in respect to the Software which is based on any
defect in the quality or condition of the Software to meet the specification
is notified to OLYMPUS SOFT IMAGING SOLUTIONS GmbH in accord-
ance with these conditions, OLYMPUS SOFT IMAGING SOLUTIONS
GmbH shall be entitled at its own discretion to either replace the Software
free of charge or repair the Software. Should OLYMPUS SOFT IMAGING
SOLUTIONS GmbH fail to repair the Software within a reasonable time
frame more than three times, the customer is entitled to resign from this
contract.

(5) The warranty is provided by OLYMPUS SOFT IMAGING
SOLUTIONS GmbH under the condition that the total price for the Soft-
ware has been paid by the due date.

(6) You are obligated to establish sufficient precautions for the case of
Software malfunctions (for example by regular data storage, frequent
backups, verification of results, emergency planning). It is your responsi-
bility to provide a suitable system environment.

6. Liability

(1) Whatever the legal grounds, liability for damage claims based only
on ordinary negligence against OLYMPUS SOFT IMAGING SOLUTIONS
GmbH (including its vicarious agents) shall exist only if OLYMPUS SOFT
IMAGING SOLUTIONS GmbH breaches a basic/cardinal obligation under
this Agreement. In this event the amount of the claims are limited to
typical and foreseeable damages. In cases of gross negligence the
liability shall be limited to the amount the User paid for the Software.

(2) Nothing in this clause shall affect personal injury and property
damage claims based on reasons of product liability.

7. Contract duration, legal consequences of violating the license
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(1) The contract is deemed to be in force for an unspecified period. The
User rights are automatically terminated if one of the conditions of the
contracts has been violated.

(2) In case of a contract violation the User has to return the original
storage devices and all copies thereof including all modified copies, all
printed and written documentation, as well as the license certificate
and/or the Software protection key to OLYMPUS SOFT IMAGING
SOLUTIONS GmbH, or the User has to destroy these items.

(3) In addition OLYMPUS SOFT IMAGING SOLUTIONS GmbH reserves
the right to file a lawsuit to claim reparations for damages, non-
compliance, or removal of the Software in case of license violations. The
following laws and/or conditions are in effect: the conditions of this
contract, copyright laws, and the laws of the German civil code (BGB).

8. Applicable Law, Place of Performance and Jurisdiction

This Agreement shall be governed by German law. The Convention on
Contracts for the International Sale of Goods (CISG) shall not apply.
Place of Performance and Jurisdiction shall be at Munster, Germany.

9. Severability

In the event a provision of this Agreement is or becomes invalid or should
this Agreement be incomplete, the validity of the remaining provisions
shall not be affected thereby. The invalid or incomplete provision shall be
substituted or supplemented, respectively, by an appropriate one reflect-
ing - to the extent legally permissible - as closely as possible what the
parties hereto had originally intended or would have intended according
to the sense and purpose of this Agreement, if the specific issue had
been taken into consideration by them
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Thank you very much for purchasing Olympus’ Screening Station for Life Science and for your confi-
dence in our products and services.

The scan® Analysis Software is designed for the automated analysis of images that were acquired by
the Olympus scan® Screening Station and with the scan® Acquisition Software. The software is intended
for the use in biomedical research.

Q The scan® Analysis Software, the scan® Acquisition Software as well as the hardware compo-
nents of the Olympus scan® Screening Station for Life Sciences are for research use only.

1.1 Abstract

This user manual will guide you through the usage of the Analysis software of the Olympus Screening
Station scanR. It will assist you in setting up efficient and reliable assays from scratch. This part of the
scan® software is intended to be used for the analysis, quantification and navigation through your data
and results. The Analysis software of scan® allows you to run the analysis during and in parallel to the-
acquisition or in “offline mode” afterwards.

Special care has been taken to guarantee correct and accurate information within this documentation,
although this is subject to changes due to further development of the screening system. Thus, the manu-
facturer cannot assume liability for any possible errors. We would appreciate reports of any mistakes as
well as suggestions or criticism.

1.2 Technical support

If you find any information missing in this manual or you need additional support, please contact
Olympus directly.
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2 Main User Interface

This chapter explains the features of the image displays and briefly introduces the different menu points
and buttons accessible from the main user interface.
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2.1 General

The scan® Analysis main graphical user interface contains four histograms and an image viewer win-
dow. The functions of these histograms are explained in Chapter 2.4, Managing histograms and scatter
plots.

The image viewer window shows the image with the object corresponding to a data point selected in a
histogram. A description of the image viewer functions is given in Chapter 2.5, Using the Image Viewer.

Navigation through the images of a scan is possible with the tools in the Image box. Color channel se-
lection is done with respective drop-down lists in the Display box.

An analysis can be started and followed online with the tools and displays in the field at the lower right of
the main window.

The menu bar at the top contains several drop-down menus and commands. They are listed in the fol-
lowing overview:

Analysis » Run: starts the analysis with the current settings

Analysis » Batch Run: starts multiple analyses with the current or individual assay settings per scan.

2 scanR Analysis: CellCycle_Chlamydia_Handbuch

Analysis Scan Kinefic View Modules Repositioning Preferences About
Selected 4 Selected

a

Area w 1.25E+3  Counts Object b w 1.25E+3  Counts Object

Circularity Factor w 1.13E+0 1 i W 270E+3| 1 i Mean Intensity DAPI  w 2.70E+3 1

Row
C

Column I
c B 0 0 4 |
Pus;tlun w 3.25E+6 Counts
Time TotallDapiCorr W 3.25E+6| 2

= Selected Wells
Interactive objects I 24724

Main -
= [CMain Display

Analysis Progress
05X (1118,36) FOV: 868.2%661.8 um Well Name / Description  C6
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Analysis » Open: opens a previous analysis (*.sca-file)
Analysis » Save/Save as: saves the current analysis (*.sca-file)

Analysis » Export Table: exports the values determined for each detected object to a spread sheet.
The values exported depend on the active view mode. When also sub-objects are detected not only one
file is exported but for every sub-object a separate list is exported. The values that are exported depend
on the active view: population view / trace view (see Chapter 4.4.4)

Analysis » Assay Settings: opens the “Assay settings” dialog to define and review the analysis pipeline

Analysis » New Assay: Resets the assay setting to default values as starting point for new assay defini-
tions

Analysis » Load Assay: loads an existing assay (*.say-file). In contrast to the *sca-file the *.say-file
contains only the analysis definitions, i.e. the operations to perform on a data set but not the results of a
specific analysis.

Analysis » Save Assay: saves the current assay (*.say-file)
Analysis » Assay Gating: opens the Gate Manager (see Chapter 4.2.2)
Analysis » Exit: exits the analysis

Scan » Open: opens a scan and assigns it to the current assay. The file types that can be opened are
the scan® experiment descriptor files (*.xml-format)

Scan » Open Last Acquired: opens the last acquired scan and assigns it to the current assay.

Scan » Relink images: re-links acquired images to an analysis. To do so, navigate to the folder where
the images are stored and select Current Folder.

Scan » Custom conversion: converts a data set acquired with another software into the scan® format
(see Chapter 7.1.1)

Scan » Plate...: selects a set of wells for analysis and data navigation; allows also to display a well
overview, i.e. an overview of the images that were acquired in a well. (see Chapter 2.7)

Scan » Reassign wells: enables you to reassign wells (see Section 2.7 Interactive plate result view).
Scan » Scan Info: displays the path to the image data

Scan » Settings: displays the settings to a scan

Kinetic » Trace View: toggles between the Population and Trace View modes.

Kinetic » Configure Tracer: opens the Trace Configuration window to select how the object tracking
is to be performed.

Kinetic » Define Parameters: opens the Trace Parameters window to select trace analysis operations.
Kinetic » Show traces: opens the Trace Viewer that visualizes the trace graphs.

View » Adjust Display...: display properties for the RGB display (affects only the displays).

View » Well Results...: opens the Well Results window (see Section 4.4, Well results).

View » Parameter View: lists all parameters for a selected object, that were determined during analysis

View » Log File: opens a log file viewer which provides technical information about the analysis process
and possible issues.

Modules » Object Finders: list and configure available Object Finder Modules (Chapter 7.4, Libraries)
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Modules » Object Analyzers: list and configure available Object Analyzer Modules (Chapter 7.4, Li-
braries)

Modules » Image Processors: list and configure available Image Processing Modules (Chapter 7.4,
Libraries)

Modules » VC Processors: list and configure available Virtual Channel Modules (Chapter 7.4, Libraries)
Repositioning » Interactive: the scan® screening system moves to the position of the selected object

Preferences: Gives access to some preferences including galleries, directories, data export and settings
for repositioning and reclassification.

About: Provides information about the software version and licenses, and offers to create a “Support
Package”. This is a .zip file containing log files and technical information which can be used for error
diagnosis by Olympus support.
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2.2 Preferences

The general preferences can be defined in the Preferences dialog.
Max Gallery Objects. Sets the maximum number of objects that are displayed in a gallery.

Sort mode. The options are Typical, Random, yx and —yx. When Typical is set, the galleries display
the objects which are closest to the center of gravity of the selected region or histogram in the order of
distance to that center. Random displays randomly selected objects within the selected region. The
options yx and —yx allow to create a gallery that is ordered by one parameter.

Overview Size. The pixel size of a single position for the well overview can be set to 80, 160, 240 pixels
(see Chapter 2.7).

Default Data Directory. Enter the directory where the data are read by default (used for
Scan » Open...)

Result Export Directory. Enter the directory where the results are to be stored. When this field is empty
the results will be stored in the <scan directory>\Population Results. The results of a tracking analysis
will be stored in the <scan directory>\Trace Results.

=4 Preferences

Galleries

Max Gallery Objects Sort Mode Overview Size
100 = Typical ~ 20 -

Directories

Default Data Directory
G

Result Export Directory
=

Positionlist Path

Configure
[JEnable Export to Imaging Software
Data Export
Export2Tit ] Export Well Descriptions
B TXT
[JFcs
Repositioning & Reclassification
Acquisition Server Reclassification Hotkey Assignment
.
o
Port
< HotKey User Parameter  Assigned Value
2055 - NUMPAD.O |~ | | UserDef 1 |o 1
Address
localhost
Remove Assignments
Analysis

Max number of threads
Number of Cores ~
Cancel OK
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Enable Export to Imaging Software. Configuration of the export of position lists of gated object to an
imaging software (cellSens or xcellence). For further information regarding this functionality, see Chapter
7.6 Export to imaging software.

Export2Txt. The results can be exported as .txt files or as .fcs files. (For export to .fcs format, see Chap-
ter 7.3). In case of exporting to .txt files, it can be chosen if the well name/description (see Chapter 2.7)
is included in the results file or not.

Acquisition Server. Set the Port and the Address for communication with the scan® screening system
for experiments with repositioning.

Reclassification Hotkey Assignment. Define hotkeys available in galleries and histograms to assign a
value to the user-defined parameters UserDef_1 and UserDef_2. These user-defined parameters can
be used to gate objects based on user input.

Max number of threads. Defines a maximum number of threads to be used for the analysis. Restrict-
ing the number of threads can be useful when running memory intense analysis because the memory
usage depends on the number of parallel running threads.

2.3 The scanR data structure

scan® analysis data can be separated into the acquired images and the analysis assay being applied to
them. The acquired images as a whole are called a scan; it includes the individual images and their
acquisition settings like color channels, exposure time, plate information etc. An assay describes the
processing and analysis steps applied to extract data out of the images.

This separation between assay settings and acquired images allows the reuse of once adapted assay
settings for different scans.

The images acquired during a scan® scan are stored as 16-bit * tif files in a data subfolder in the exper-
iment scan storage folder.

Additionally, the scan settings are stored in an experiment_descriptor.xml and the stage positions in
the Acquisitionlog.dat file.

The scan® Analysis software serves for the analysis of the scans. The instructions (assays) for these
analyses are stored in the scan® Analysis/Assays folder as *.say files. These files can be loaded via
Analysis » Load Assay... to then apply the assay on a scan data set.

Once an analysis has been performed, i.e. the analysis steps defined in an assay have been applied to
scan, a *.sca file is generated and can be stored in the experiment storage folder. These files contain all
analysis data including histograms and scatter plots etc. *.sca files can be loaded via Analy-
sis » Open... to revisit the analysis results.

When opening a scan via Scan » Open... the experimental settings of a scan will be loaded
by reading the experiment_descriptor.xml file and the images of the scan will be available

9 for browsing and analysis. In contrast to this when opening an analysis (*.sca) file via Anal-
ysis » Open... all results of the saved analysis will be opened together with the images, al-
lowing review of the results.
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2.4 Managing histograms and scatter plots

Histograms are used in scan® for data representation, classification and navigation. scan® uses 2-D and
1-D histograms following the common representation in cytometry.

A 1-D histogram shows the frequency distribution of only one parameter. A 1-D histogram is created
when the same parameter for X and Y is selected. On the X-axis of the histogram the selected parame-
ter and on the Y-axis the number of counts is plotted.

A 2-D histogram (scatter plot) is a plot of one parameter of a number of objects against a second pa-
rameter. Color-coding is used as "third dimension" to represent the frequency of occurrences.

The data displayed in a histogram are assigned to an object type (main-/ sub-object). The detection of
the objects is defined by the assay. The object type can be chosen from the Object drop-down list un-
derneath the histogram. The X and Y drop-down lists are then automatically updated to correspond to
the measured parameters of the chosen object type (see assay definition). The X and Y drop-down lists
are used to change the parameters displayed in a histogram. The axes of abscissa and ordinate are
labeled with the chosen parameter.

Selected 500 | | | Sele

0.0 0
0.0 750.0 100 0.01500.017 .0 0. 1p000Q0.0
api_orr

Object b, TotallDapiCorr
Main TotallDapiCorr

A selection of buttons are located in the lower right corner of each histogram. They allow toggling be-
tween the Navigation mode, the Zoom mode, the Pan mode, and the Region Drawing mode. In the
upper right corner buttons are located for auto scaling and automatic region drawing actions.

Navigation u

The Navigation button with the pointer symbol allows navigating within the data. Each data point within
a histogram is directly linked to the object from which it is derived. A selected data point is highlighted by
a red circle in all histograms in navigation mode as long as the data point is within the displayed area.
The corresponding object is displayed in the Image Viewer. The X and Y values of the data point are
displayed next to the X and Y drop-down lists. Holding and dragging the mouse using this tool allows to
virtually following the objects changes within the parameter set. The navigation tool also allows dragging
and modifying existing regions.

Zoom m
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The Zoom button with the magnifying glass symbol allows zooming into and out of the data. When
Zoom mode is enabled, clicking into the histogram zooms in and clicking while the [SHIFT] key is
pressed zooms out.

Pan u

The Pan button with the hand symbol allows shifting the current view port of the histogram.

Region BD

The Region tools are used to draw polygons into a 2-D histogram and to set a range in 1-D histograms.
Regions define bi-dimensional intervals within the parameter range and thus subpopulations of data
points. Double-click in order to close a region in a 2-D histogram.

Auto Scaling

The Auto Scaling button re-scales the histogram for optimal visibility. As long as it is enabled, the histo-
gram axes will adapt to the data range and re-scale the axes if necessary when new data points are
added.

Auto Regions

The Auto Region tool with the magic wand symbol is used to find and draw regions automatically. The
regions are detected depending on the current zooming level to identify subpopulations of interest.
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2.4.1 The histogram context menu

Show Region

Clone From
Gallery
7R0.0 8 Foom out
50000 oL R | Settings
250.0 ;
0.0 Save as..

250.0 500.0 750.0 100)  Copy 2000.0 lHl
Area

Object Area w 1.25E+3  Counts
Main w vy Mean Intensity DAPI  w 2.70E+3 1

The histogram can be managed through the context menu accessible via right-click into the histogram.
(Note that you will get the region context menu, if you right-click on a region border as described below).
The histogram context menu contains the following commands:

e Set Gate. Apply a gate on the selected histogram by choosing a region from the list that appears.

e Show region. Select a region from the list that appears to generate a zoomed-in view of it with the
X/Y parameters that were used to define this region.

e Clone from. Select a histogram from the list that appears to duplicate the histogram.

e Gallery. This command generates an image gallery of objects in the current histogram. The number
of images and the selection criteria are set according to the gallery preferences given in the Prefer-
ences dialog.

e Zoom out. This command zooms out of the current view by a factor of 2 (in case of linear axis scal-
ing).

e Settings. This menu item opens a new dialog with options to customize the histogram appearance.

e Settings » Autoscale XY. This command activates automatic scaling of the X and Y axes. Auto scal-
ing will remain active until it is deactivated again or the histogram is zoomed manually.

e Settings » Autoscale Z. This command activates automatic scaling of the Z axis, i.e. the “height” of
the histogram bins. Auto scaling will remain active until it is deactivated again.

e Settings » Color Gating. This command causes the population of each gate to be displayed in a
different color in the histogram.

e Settings » Show Legend. This command toggles display of the color gating legend in the histogram.



12

Chapter 2 — Main User Interface

OLYMPUS

e Settings » Theme Select a theme for visualization of the histogram data and general style of the

histogram.

e Settings » Advanced... This command opens the Histogram Properties dialog with expert settings

described below.

e Save as... This command enables saving the current view of the histogram into an image file

e Copy... This command copies the current view of the histogram to the clipboard.

2.4.2

=4 Histogram Properties

The histogram properties

dialog

Axis attributes

x Minimum | 0.00 y Minimum

% Maximum | 2000.00 =

% Precision 1

Color table bin width
0.287218
[z log

Color scheme

Binned color table

0.00

y Maximum 4000.00

y Precision 1
xFormat| Decimal |+ | yFormat| Decimal
xlog | OFF ylog| OFF

Alr [l

w

Grid cosmetics

Line color

Text color White ~

Tick length (3) 3
Visible grid OFF

Crossing axes OFF

Color Gating []
Show Legend []
Disable Auto Z Order[]

NN [ [ [ T[T T TTT]

Autoscale

LinlncFact| 0.5 =

LogPots 10

Autoscale Z

Z Clipping [%] | 1 -

1D Histogram Caolor

BKColor .
Selector Color .
ROl Color

[ = ]

Cancel

-~

Axis attributes. This field offers different choices to set the axis scaling.

Grid cosmetics. This field offers different choices to set the grid display.

Autoscale. This field offers different choices to set the auto scale of the axes.

BKColor. A click on the colored field opens a window that allows selecting the background color.

e

—
[ ———

User

OOO00oooOoooooooooon
History System
OO00O0000000 OEOmmn

G- oc os 0 ...

Selector Color. A click on the colored field opens a window that allows selecting the cross-hair color.

Region Color: A click on the colored field opens a window that allows selecting the color of the region

outline.
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Color scheme. This color palette defines the coloring of data points (pixels) in the histogram in depend-
ence of the number of counts (events) they represent. For example, if the Color table bin width is set to
three and a data point represents 7, 8 or 9 counts, it will be displayed in the third color from the left.

Color table bin width. It defines the range of counts to be given the same color from the Color
scheme.

Binned color table. Click this button to activate the color binning as set in Color table bin width.

Color Gating. This command causes the population of each gate to be displayed in a different color in
the histogram.

Show Legend. This command causes a legend of the colors in the Color Gating mode to be displayed
in the histogram.

Disable Auto Z Order. Disables the automatic determination of z order for 1D histograms.

2.4.3 Theregion context menu

The region context menu will open, if you right-click on a region border

foom to
Gate

Region Gallery

e Remove. Deletes the selected region or gate.
e Zoom to. Gives a zoomed view of the selected region.

o Gate. Creates a new AND Gate defined by the region and the Gate currently applied to the histo-
gram. (See also Chapter 4.2.2, The gate manager.) When a gate is applied to a histogram, only the
data points within this gate are displayed. To display all data points open the histogram context
menu and go to Set gate » none.

e Region Gallery. This command generates an image gallery of objects in the selected region. The
number of images and the selection criteria is set according to the gallery preferences given in the
Preferences dialog. (For more information see Chapter 2.2 Preferences).

13
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2.5 Using the Image Viewer

(532,19) FOV: 217.0x165.4 um Well Name / Description B2

Each analysis data point is directly linked to the image object it is generated from. These objects can be
displayed in a close-up view in the Image Viewer. Browsing the data set by clicking on data points with
the histograms Navigation tool leads to a corresponding update of the image in the viewer. Additionally,
the Row/Column, Position, Time fields in the Image selection box and the Well/Name Description
fields are updated and give information about the image origin and other context. The +/- buttons next to
the Row/Column, Position and Time fields can likewise be used to navigate. Values can be typed in to
select images of a particular well, position or time step. The larger +/- buttons in the Image selection box
can be used to switch to the next available image or browse through all available images by holding the
button pressed.

Display. Multi-color images consist of individual color channels that were recorded with different optical
acquisition settings (e.g. different excitation filters). The red, green and blue drop-down lists serve to
select the input for the three color channels that are displayed in the respective colors. In order to dis-
play a channel (e.g., a transmission channel) in grayscale, select it from the gray drop-down list. When
having both grayscale and any color selection active, a combined multi-color image with transmission
overlay will be displayed.

The clipping of the RGB display, i.e., the scaling of the image display brightness, can be changed via the
menu item View » Adjust Display... that opens the Adjust Display window.

Display: Processed. Click this button to toggle between the original image and the processed image as
defined in Analysis » Assay Settings in the Image Processing tab. Image processing might improve
the quality of the displayed image but slows down the systems image display. Therefore it is especially
recommended to switch it off for performance reasons when creating galleries. The image processing is
described in Chapter 3.8, Image processing.
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Image: Row/Column/Position/Time. Use these entries to select a specific image to be displayed.
The +/- buttons allow fast navigation through your image data set by incrementing or decrementing the
Time, Position and/or Well number.

Interactive objects. Select the object type (the main object or any sub-object) to be outlined and se-
lected in the display when clicking on an object or data point.

The Image Viewer is equipped with a tool bar to select different mouse tools:

Zoom E

The Zoom mode is used to zoom into the displayed image. A click into the image causes a zoomed-in
view with the cursor position as the center. To zoom out, the Shift key must be pressed simultaneously.

Selection u

The Selection mode allows selecting individual objects within the image via mouse click. The object
type to be displayed can be selected in the drop-down list in the bottom left corner of the image viewer.
Main objects are highlighted by a green outline. The data point corresponding to the selected object is
highlighted with a red circle 2-D histograms and a vertical red line in 1-D histograms.

Move u

Depending on the zoom factor, only a part of the image will fit into the display. The Move mode allows
moving the visible area via mouse-drag.

The status bar in the lower left corner shows information about the magnification of the displayed im-
age, the current x/y position of the cursor and the pixel value(s) at this position. Furthermore the status
bar shows the dimensions of the current field of view (i.e. the currently displayed part of the image) in
micrometers as calculated from the scan settings.

2.6 Adjusting the image displays

View » Adjust Display opens the Adjust Display window that allows adjusting the display brightness.
Note that these image settings affect the front panel display as well as well overviews and galleries.

A raw image will always have a certain background intensity. Also, one will avoid to over saturate imag-
es and — especially in fluorescence applications — rather use only a fraction of the dynamic range of the
camera. The consequence is that a raw image appears usually low in contrast and may even appear
entirely black. Clipping is applied to change the image brightness by defining a fraction of low pixel
intensities to be displayed black as well as a fraction of high pixel intensities to be displayed with maxi-
mum brightness.

Clipping Type. This checkbox toggles between Dynamic [%] and Absolute clipping.

15



16

Chapter 2 — Main User Interface OLYMPUS

s Adjust Display

Selected Channel Channel Display Settings
DAPI
Cy3 Absolute

Clipping Type
Eﬁ.baolu‘te

Gray scale palette
Grayscale -

Use Scan Settings Cancel

Dynamic [%]. Define here how many pixels (as a percentage of the total number of pixels) will be dis-
played with maximum and minimum brightness. The intensity of the remaining range of pixels will then
be scaled linearly in between. The higher the numbers the stronger the resulting contrasts.

Absolute. Define here the range of pixel counts to be displayed with maximum and minimum brightness
by dragging the red horizontal lines — that represent the maximum and minimum thresholds — with the
mouse. The intensity of the remaining range of pixels will then be scaled linearly in between.

Gray scale palette. The channel selected in the gray drop-down list in the main GUI can be displayed in
different false-color palettes that can be selected here.

Use scan settings. Apply the display settings used for the scan.

2.7 Interactive plate result view

The results of all measurements can be displayed interactively in the Plate window. To open this win-
dow, go to Scan » Plate... In the center of the window you will find a graphical representation of the
screened plate. When the window is opened for the first time, the wells that were skipped during acquisi-
tion are shown in gray; the scanned wells show a different color.
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a0 k1| 92

Left click to toggle wells on/off
Mouse-drag (+ Ctrl) to select (deselect) wells
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Object type
Main
Measurement type
Counts %
Gate
G1

Reference Gate

All

Well Results Descriptions > >

Restore

By default all screened wells will be taken into account for analysis. Adjusting the well selection is done
similar to the well selection in the scanR Acquisition software, i.e. to change the selection you can click
on the wells. To deselect multiple wells you can press Ctrl on the keyboard and draw a rectangle with
the mouse around the wells to be excluded. When a well is deselected, the corresponding data points
will be removed from all histograms. To include a deselected well again, click on the well. It will again be
displayed in a color other than gray and the corresponding data points will be shown in the histograms.

The Restore button will restore the initial well pattern.

A well overview of each well can be shown by right-clicking on one of the wells and selecting Well
Overview. To change the overview size of an image, go to Preferences. The size can be set in the
Overview Size drop-down list. It can be useful to decrease the resolution of the well overview for large
overviews in order to increase the speed of the display.

B wellNo... — O *

2 o

10580 13

210:160 1

BZ well No. 15, B3 - O ¥

542401

To display a heat map of the measurement results you have to run the analysis first and then proceed
as follows: Select the object type (main object or sub-object) from the first drop-down list (Object type)
on the right. The drop-down list Measurement type allows you to switch between Counts, Counts%,

Mean, Error, Error% and CV%.

17
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= Plate

29.7
Object type
Main
Measurement type
Counts %
Gate
G1

Reference Gate

All

Well Results Descriptions > >

Left click to toggle wells on/off

Mouse-drag (+ Ctrl) to select (deselect) wells Restore

When Counts is selected as Measurement type, you can select the population you are interested in in
the Gate drop-down list. Here all defined gates can be selected. You can select the population, you want
to use as reference in the Reference Gate drop-down list. Here also all gates that you have created in
the histograms can be selected. The wells will now be displayed in a color that indicates how many cells
in every well are found in the selected gate. When a well is displayed in orange, many cells of this well
can be found in the selected gate, whereas a green color indicates, that only few cells can be found in
the selected gate.

The same applies when Counts% is selected as Measurement type, in this case however, the color will
indicate the percentage of cells that are in the selected gate.

When Mean, Error, Error% or CV% are selected as Measurement type, again the Gate drop-down list
contains all gates that you have defined. However, the next drop-down list now allows you to select the
Measurement to be performed. Here all parameters that you have previously defined in Edit As-
say » Measurement Parameters (see Chapter 3.6 Measurement parameters) and in Derived Parame-
ters (see Chapter 0

Derived parameters) can be selected from the drop-down list. For example, if the parameter Area is
selected as Measurement and Mean is selected as Measurement type, the mean area of all cells per
well will be color encoded. This means that wells with very large cells will be displayed orange, whereas
wells with smaller cells will be displayed green.

o The Plate view is fully interactive and updated automatically. When a gate is modified in the
front panel, the results will automatically update in the Plate view.

Next to the color gradient bar indicating the display range, you can set how the range of the color display
will be adapted when the same assay is run on a new data set. The display range can then be either
adapted in Dynamic mode, which means the min and max values of the display range will be adapted
according to the new data set. Alternatively, the range can be kept in Absolute mode, which means the
range that you have set in the first place will be used for all other analyses.

In order to change the display range manually, you can directly enter min and max values at the bottom
and the top of the color bar, respectively. When you change the range manually, the display range mode
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will automatically change from Dynamic to Absolute. The Adapt button can then be used to adapt the
min and max ranges of the color display to the current data set and when a new experiment is ana-
lyzed, also this display range will be used. Switching back to Dynamic will also restore the min and max
values of the display, but when a new experiment is analyzed, the min and max ranges will be adapted
to the results of the new dataset.

A click on the Descriptions button opens the Name/Description list. This list displays all selected wells.
By default, the wells will be named Al, A2 ... etc. The names of the wells can already be changed to a
customized and more descriptive name when setting up the acquisition (see scan® Automated Image
Acquisition Software, Chapter 4.1.1 Well pattern). Alternatively, the names can be changed now in the
Plate window. Click in the Name/Description field you want to change and enter a new name.

Note: when the same name is used for multiple wells, these wells can be grouped. In the

0 Measurement Results and Populations tabs of the Well Results window (see Chapter 4.4
Well results) you can then switch between Wells and Groups to have each well listed indi-
vidually or to show the results of the created groups.

A second click on Descriptions hides the Name/Description list.

19
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3 Assays

Assays are the protocols that define how to extract the data of interest from the images of a scan. They
define which objects are to be recognized and how and which measurements are to be performed on
the found objects. This chapter explains in detail how assays are to be set up or modified.
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3.1 General

An assay defines all steps necessary to extract quantitative data from the acquired images. It usually
starts with some sort of image processing like background correction. Secondly, objects have to be de-
tected in the images. The analysis, for example different kinds of measurements like area, intensity,
shape..., is finally performed on these objects and results for the samples (e.g. wells) are generated.

The Analysis » Assay Settings... command opens the Assay Settings window and allows applying or
adapting the assay to the loaded scan. The Assay Settings window contains seven tabs: Main Object,
Sub-objects, Parameters, Derived Parameters, Image Processing, Virtual Channels and Image
Export. The tabs are arranged from left to right, but you can always jump back and adjust the settings of
former steps. However, background correction (in the Image Processing tab) should be performed prior
to object detection as it changes the intensity values.

scan® distinguishes between two kinds of object types: any assay always defines one Main Object type
and up to four Sub-object types connected to it. To give an example, main objects may be individual
cells while their sub-objects are individual structures within them.

To represent this hierarchical structure, the Assay Settings tabs Main Object and Sub-objects are
used to set the search algorithms for main and sub-objects in order to extract the structures of interest
from the images. This is done by different Object Finder Modules that implement different rules for
object detection.

The Parameters and Derived Parameters tabs contain the definitions of the kind of information to be
extracted from the objects (e.g. area, shape,...) .

The Image Processing tab allows defining image processing steps that are to be executed before the
object detection and parameter extraction.

In the Virtual Channels tab new channels can be created as a result of post-acquisition image pro-
cessing (e.g. spectral unmixing).

The Image Export tab allows selecting one or more color channels. The processed images of the se-
lected color channels will be exported once available when the analysis is running. Color channels with
time-consuming processing steps can be added to the list automatically by enabling the Processed
Image Buffering option. The exported, processed images will be used as a buffer to avoid re-running
image processing.

3.2 Assay bit depth

All image processing operations, measurements and threshold definitions can be done with 12 bit or 16
bit precision. While there are still scientific cameras available which only have a dynamic range of 12 bit,
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16-bit cameras are the standard for some time. All new assays in scan® will automatically be 16-bit as-
says and make use of the full precision of modern camera raw data.

For backward compatibility reasons, 12-bit assays can still be used without functional limitations. If they
are used with 16 bit image raw data, only the most significant 12 bits of the image data are utilized. This
means the 4 least significant bits which mostly contain noise and not signal are ignored but it is possible
that precision is not sufficient for analysis of very low signal data.

Existing 12-bit assays can be up-converted to 16-bit assays by clicking the 16 bit button in the Assay
Settings dialog which is only available for 12-bit assays.

Compatibility Status
- Cancel OK
[ [esit >

If a 16-bit assay is used with 12 bit raw data, all intensity values are converted on-the-fly to 16 bit for
analysis without loss in precision. Original data (image data in a scan) is never modified.

3.3 Object finder: detecting main objects

The Main Object tab of the Assay Settings window provides the commands to define the Main Object
detection.

Color Channel. Select the color channel on which the main object detection is to be performed.

Module. Select the method to detect individual Main Objects from the drop-down list.

Module
Edge
Image
J/ Edge
Intensity

23



24

Chapter 3 — Assays

OLYMPUS

@ Assay Settings x
Main Object Sub-ohjects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Main-object finder Module settings
A
Name #--  Settings
Main
Color Channel
DAPI ~
Module
Intensity ~
Settings list
Default w
Adjust
Image segmentation o
< >
o :
View
Add to list
Image Selection for Module Adjustment  Wells Paositions Timesteps
+ Reset All All All
Cormpatibility Status
D Fix CCs - Cancel oK

Settings list. Each Object Finder Module has a list of preset parameters. The lists can be modified
and stored at will. Individual modifications of these settings are marked as Modified. Select the settings
of choice from the drop down list.

Adjust. This command opens the configuration dialog of the selected Object Finder module. (For chang-
ing the list of Object Finder modules see Chapter 3.5, Object finder modules)

Module settings. This field lists the current settings of the selected Object Finder module.

Add to list. This adds the modified settings to the Settings list. Click the button to open the Add Set-
tings to OFL window (Object Finders Library, see Chapter 7.4.2, Object finders library (OFL)) where
you can provide a New Settings Name for the modified settings list.
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EX View Segmentation

kloleFo

oero.

13441024 2X 16-bitimage 895 _(396,508) 12441024 2 16-bitimage 227 (657,717)

Image List
B1--W00D13--P00002-~Z00000--T00000—-DAPI£iF

>

B1--WD0013--P0O0003--Z00000--TOO000--DAPLtF
B1--WD0013--P00004--Z00000--TO0000--DAPLtf
B1--W00013--P0O0005--Z00000--T00000-- DAPLtf

B2--WO00014--P00001--Z00000--TO0000-- DAPLtf
B2--WO00014--P00002--Z00000--TO0000-- DAPLLF
B2--WO00014--P00003--Z00000--TO0000-- DAPLtf
B2--W00014--P00004--Z00000--TOO000- - DAP|.tif
B2--WD0014--P0000S5--Z00000--TOO000-- DAPLtF
B2--WD0014--P0O0006--Z00000--TO0000--DAPLtF R

Cancel oK

Image segmentation. This function divides — if activated via the check box — the entire image into seg-
ments: as many segments as there are Main Objects where each segment is assigned to the Main
Object in its center. In other words, each image pixel is assigned to the Main Object it is closest to. All
pixels that are assigned to the same Main Object form one segment of irregular shape and size. The
View button opens the View Segmentation window that contains on the left a display of the image con-
taining the objects and on the right a display of the segments.

3.4 Sub-object finder: detecting sub-objects

Sub-objects are structures that are directly linked to individual Main Objects. The search for Sub-
objects takes place on an image mask derived from the corresponding Main Object. This Main object
mask can be adapted for each Sub-object type separately.
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Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Sub-object finder Sub-object
Hame [Nucleoli
A
MNucleoli New
Color Channel
Cy3 ~
Remove v
Module
Intensity ~
Settings list Module settings
Default w ~
T Settings
Adjust
Main object mask o
< >
O
Modify
Add to list
Image Selection for Module Adjustment  Wells Paositions Timesteps
+ Reset All All All
Cormpatibility Status
D Fix CCs - Cancel oK

Sub-object finder: Color Channel, Module, Settings list, Adjust, Add to list. These functions are
analogous to the ones described in the previous Chapter 3.3, Object finder: detecting main objects.

Name. Give a name to each new Sub object. The default name is Subobject 1.

Sub-object list. It gives an overview of the defined Sub-object types. The New and Remove buttons
allow the insertion and deletion of Sub-object types.

Main object mask. Each individual main object found in an image creates a mask. The individual sub-
objects are associated with this mask rather than with the main object itself. Imagine, a main object is
the cell nucleus and the sub-objects are structures outside of it. In order to be detected, the original main
object mask — which only covers the area on the nucleus — needs to be modified in order to enable the
detection of the sub-objects.

Click the checkbox to enable the image mask modification of the main object.

Modify button. Click here to open the Modify Object Boundaries dialog to adapt the main object mask
to the needs of the sub-objects detection.

Distance. The distance is measured in pixels from the outer rim of the main object mask (positive and
negative values are valid)
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B Modify Object Boundaries

Settings

Distance

-2

Width
10

1344x1024 1X 16-bit image 0 (733,435)

Overlap Treatment
Segment

(E]ie}

| 13441024 1X 16-bit image 0~ (307,509)

Images

B1--W00013--P00002--Z00000-- T00000--DAP| tif

B1--W00013--
B1--W00013--
B1--W00013--
B1--W00013--|
B2--W00014--|
B2--W00014--|
B2--W00014--|
B2--W00014--
B2--W00014--
B2--W00014--

P0OD03--Z00000--
P00OD04--Z00000--
P0OD0S5--Z00000--
PO0006--Z00000--
PO0001--Z00000--
PO0002--Z00000--
PO0003--Z00000--
P00D04--Z00000--
P00D05--Z00000--
P0O0OD0G--Z00000--

-T0ODOO--|
-T0ODOO--|
-T0ODOO--|
-T00000--|
-T00000--|
-T00000--|
-T00000--|
-T00D00--|
-T00D00--|
-T00D00--|

DAPI.tif
DAPI.tif
DAPI.tif
DAPLtif
DAPLtif
DAPLtif
DAPLtif
DAPItif
DAPItif
DAPItif

Cancel oK

Width. Extension of the sub-object mask in pixels.

The examples below illustrate the effects of these parameters.

Main object mask

Distance 0, Width 1

Distance -5, Width 5

Overlap treatment. Options are Segment, Segment (slow) and remove.

Distance 8, Width 8

When sub-objects are used for analysis, a further parameter becomes available in the Pa-
rameter tab (see Chapter 3.6, Measurement parameters): Subobject 1 counts (if the de-
fault name for sub-objects is used, otherwise it would be subobjectsname counts). This
parameter gives the number of sub-objects detected for each main object and is a parame-
ter of the main object.

27
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3.5 Object finder modules
3.5.1 Entireimage

This is a very simple object definition: the entire Image is used as object. You may use this for meas-
urements of integral intensities of your sample, i.e., for each image and each parameter (see. Chapter
3.6, Measurement parameters) a single value is calculated, independent of the objects within the image.

Ignore frame. This is the only parameter to adjust: the size of a bordering frame to be ignored. The
default value is 0 (no bordering frame).

When used as object finder module for sub-objects, the Image object finder will deliver the entire mask
of the main object or the modified mask.

3.5.2 Intensity threshold

As the name says, the Intensity threshold method is based on intensity values: pixels with intensities
above a predefined threshold will be united to one individual object.

The Object Finder: Intensity Threshold dialog has two image viewer displays. The left one shows the
gray value image including all detected objects marked with a red bounding box. The right one shows
the mask of each object, visualized by different colors for separate objects and black for background.

B Object Finder: Intensity Threshold - ®

o
O

| 13441024 1X 16-bit image 3526 (€89,612) Intensity clipping 0 | 13441024 X 16-bitimage 0 (0,0)
Settings Objects found Images
283 B1--W00013--POOD02--Z0D000-- TO0DOD--DAPLtif -
B1--W00013--POD03--Z0D000-- TO0DOD--DAPLtf
= B1--W00013--POD0--Z0D00D-- TO0DOD--DAPLtif
Threshold Auto 1000 |5 B1--W0DD13--PD0DOS--Z0D0D0--TO0000--DAPL tif
B1--W00013--POODOS--Z0D00D-- TO0DOD--DAPLtif
o B2--WO0D014--POODO1-~Z0D0DO--TO0000--DAPLEiF
B2--W00014--PDOD02--Z0D00D-- TO0DDD--DAPLE
[ignore border objects B2--W00014--P0D04--Z0D00D-- TO0DOD--DAPLtf
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[AMinimum object size 100 + (pixels) B3--WO0DO15--PDOD01--Z0D00O-- TODDOD--DAPLtif v
[AMaximum object size 1000000 z (pixels) e nnenen memens e e

Cancel oK
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Settings

The settings used when opening the window depend on the Settings list selected in the Main Object or
Sub-object tab (see Chapters 3.3 , Object finder: detecting main objects and 3.4, Sub-object finder:
detecting sub-objects) and are loaded from the Object Finders Library (see Chapter 7.4.2, Object find-
ers library (OFL)).

Threshold. This is the intensity cut-off for objects. Type in a value or use the arrows to adjust it.

Threshold: Auto. Click this button to automatically evaluate the image background and set a meaning-
ful cut-off value.

Watershed. If neighboring objects are so close together that thresholding does not lead to a clear
separation, they will be detected as one object. (See left image pair below.) The watershed algorithm
separates these objects along the contractions of the detected masks. (See right image pair below.) Set
the toggle button to ON to use this option.

Ignore border object. Check this box to ignore all objects that are cut-off by the image border.
Fill holes within objects. Check this box to fill the object mask in case it contains holes.

Minimum/Maximum object size. Check these boxes and adjust the values to apply minimum and max-
imum size filters to the objects (in order to ignore objects that are outside these size limits).

3.5.3 Edge detection

The Edge Based Segmentation module is a general purpose edge based particle detector. The idea of
the algorithm is to find a closed contour around each particle. First the edges of the image are extracted.
For those edges which already form a closed contour, the algorithm is finished. Since the remaining
open edges may be part of a closed contour around a particle, the algorithm then tries to combine these
open edges so that they form a closed contour as well.

The edge detection algorithm yields better results when objects of strongly varying inten-
sity have to be detected. In these cases the threshold detection will either lead to clusters
when the threshold is set to a low value in order to detect also dim objects. If a higher value
for the threshold is set, then the dim particles will be missed. Furthermore, as edge detec-
tion is intensity independent it is especially suitable for cell-cycle analysis.
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E& Object Finder: Edge Based Segmentation
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To reduce complexity, the process of finding the best settings is split up into three independent steps.
The three groups of settings in the Object Finder window reflect these three steps. They are traversed
from left to right, but you can always jump back and adjust the settings of former steps. In each step, the
result of adjusting the current step’s settings is shown in the image above.

1. Contrast Optimization. On the left side, select an image of your choice from the list. Adjust
the contrast either by pressing Auto or manually by moving the green bars in the histograms.
If one or both bars are missing, just press Auto once. Try to clip away any unwanted noise or
artifacts while maintaining good contrast between the particles you want to detect and the
background.

2. Edge extraction. Click on the image or the settings group in the middle to get to the second
step. In this step, the edges of the image are extracted. First grab the Maximum object size
slider and adjust it so that the largest particles you want to detect just match inside the yellow
circle appearing in the images.
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3. Adjust the Selectivity slider to get just the strong edges (up) or also the weak edges (down).
Try to increase the selectivity as much as possible, thereby removing edges due to noise and
artifacts, without letting gaps in the contour of wanted particles get too large. As you can see
in the image above, contours with closed edges are marked green while contours with open
edges are red.

Edge detection

Selectivity Max. object size
1 1024
09
08
0,7
100-CJ
0,6
0,3
(]
04
03
10
0.2
01
o] 2

4. Edge Closing. Click on the image or the settings cluster on the right to get to the third step.
In this final step, the open edges extracted in step two are now closed by combining them with
other open edges. You can then filter particles by size and closure quality, split them with the
watershed algorithm or select a hierarchy.
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Particle detection

A CI d
Filtering e

O Ignare border objects

Minimum ebject area

1 10 100 1000 10000 90000

Minimum closure quality

0 0.2 04 0.6 0.8 1

Particle hierarch Splitting

Selection mode
Best Closures L Watershed
Particle Level

= Preview mode

First decide if there may have already been sufficient particles detected in step two (the green
ones). If you think so you can skip the closing process by unchecking Close edges, thereby
reducing processing time dramatically. All unclosed edges (red) are discarded then. In most
cases, however, the loss of particles is too high with Close edges being unchecked. If Close
edges is checked, you can see in the middle image that the open edges (red) are connected
to a closed contour by yellow lines.

In the Filtering settings you can filter (i.e. exclude) particles by location, size and closure
quality. The closure quality is a rating attributed to each detected particle, which describes the
quality/reliability of the respective closure. Particles whose contour has already been closed in
step 2 (the green ones) have closure quality 1. Especially when particle detection is difficult,
you can at least filter out most of the wrongly detected particles by moving the Minimum clo-
sure quality slider towards 1.

By checking the Watershed checkbox, you can split particles which have merged. The algo-
rithm inspects the shape of each particle, splitting it at constrictions. This can be extremely
useful when detecting nuclei.

Sometimes detected particles are nested into each other. E.g. spots inside nuclei or nuclei in-
side the cytoplasm. Since overlapping particles are not allowed, the Particle hierarchy set-
tings provide options to select the nesting or hierarchy level you are interested in. See below
for the function of the Selection mode options.

Don't forget to check other images of the scan to verify that your settings work with them as
well. When you are satisfied with your settings click OK in order to complete the setting up of
the image detection.
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Level O Level 1

The options at the Selection mode dropdown list are:

Min level. Selects all level O particles.

Max level. Selects all particles which do not have other particles nested inside.
Selected level. Selects all particles with the specified level.

Best closures. Selects for each nesting branch the particles which are best according to their closure
quality.

3.6 Measurement parameters

The scan® Object Analyzer modules in the standard configuration offer a large number of individual
parameters that may be measured for each recognized object. To limit memory utilization and save CPU
time, only the values for the parameters listed in the Assay Settings » Parameters list will be extracted
during the analysis.

33
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BEZ Assay Settings X
Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export

Parameters Measurement
ID | Measurement Channel Object A Total Intensity ~
pl | Area Main
p2_| Center¥ Main Color Channel
p3 | CenterX Main DAP| -
pd | Position Main
p3 | Circularity Factor Main X
pb | Area Mucleoli Object

Main ~
pd | Mean Intensity DAPI Main
p% | Total Intensity Cy3 Main
pl0 N!ean In.tenslty Cy3 Main New Remove
p11 | Circularity Factor Muclecli
pl2 | Total Intensity DAPI Muclecli
pl13 | Mean Intensity DAPI Muclecli
pld | Total Intensity Cy3 Mucleali i
pl15 | Mean Intensity Cy3 Mucleali

w
Cormpatibility Status
D Fix CCs » Cancel oK

Parameters list. Each Measurement is labeled with an ID (p1, p2,...) and is assigned to the Main Ob-
ject or a Sub-object and — depending on the type of measurement — may be assigned to a Color

channel.

Measurement. Select a parameter from the drop-down list. The available parameters can be adapted
through Modules » Object Analyzers (Chapter 7.4.1).

Color channel. Assign a Color channel from the drop-down list to the newly added parameter.

Object. Assign an Object type from the drop-down list of available object types. The image mask of this
object defines the parameter measurement area.

New. This allows inserting a new parameter into the list.

Remove. This deletes the selected parameter from the list.

Auto. Press this button to add a number of standard parameters for the main objects and all available

sub objects to the list.

A special parameter is available in the Measurement list when Sub-objects are used:
Subobject 1 counts (if the default name for sub-objects is used, otherwise it would be
subobjectsname counts). This parameter gives the number of sub-objects detected for
each main object and is a parameter of the main object.

Measurements available by default:

¢ Total Intensity. Sum of the intensity values of all pixels of an object.

¢ Mean intensity. Average of the intensity values of all pixels of an object, i.e. the Total Intensity

divided by the Area.
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Max Intensity. Intensity value of the pixel of an object which has the highest value.
Min Intensity. Intensity value of the pixel of an object which has the lowest value.
Area. The count of pixels of an object.

Circularity factor. The Perimeter divided by the circumference of a circle which has an area equal
to the area of the object (Heywood Circularity Factor).

P
Circularity Factor = ——
Y 2vVmA
Perimeter. Pixel length of the boundary of an object. Since the object is represented by rectangular
pixels, the corners of the boundary pixels are subsampled to increase the accuracy of this parameter.

Max Feret Diameter. The longest distance that can be measured between 2 points of the object
perimeter.

Elongation Factor. The ratio of the long and the short side of a rectangle with an area equal to the
object area. The long side of the rectangle is defined by the Max Feret Diameter.

Most Frequent Class. An advanced parameter used for neural network classification. Neural net-
works can output a new Virtual Channel where each pixel's values represent the classification result.
The Most Frequent Class gives the dominant classification for the whole object when used on the
Virtual Channel (See Chapter 6.5 Standard classification workflow)..

Entropy. An advanced parameter used for neural network classification. Entropy describes the dis-
tribution of different classifications for different pixels within an object and is a measure of classifica-
tion quality (See Chapter 6.5 Standard classification workflow).

Well. Well ID of the well in which the object has been detected.
Position. Well position ID of the image in which the object has been detected.

Time. If a time-lapse has been acquired, this value returns the ID of the time-step in which the object
has been detected.

z-slide. If a z-stack has been acquired, this value returns the ID of the z-layer in which the object has
been detected.

Center X. Position of the object in X within the image.

Center Y. Position of the object in Y within the image.

X. Physical position of the object in X based on stage coordinates (um).
Y. Physical position of the object in Y based on stage coordinates (um).
Z. Physical position of the object in Z (um).

UserDef_1/2. User-defined values based on reclassification hotkey assignment (See Chapter 2.2
Preferences “Reclassification Hotkey Assignment”).
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3.7 Derived parameters

The Assay Settings » Derived Parameters tab allows performing calculations on the Parameters de-
fined in the Measurements list by the use of algebraic expressions (+, -, x, +, sqrt,  etc. For a complete
list see Appendix 6.4). This is especially useful for parameters assigned to different Color Channels.

@ Assay Settings x
Main Object Sub-cbjects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Derived Parameters Name
| D | MName | Formula ~ NucleoliArea
D1 | TotallDapiCorr p7-(p1-5001*175
Formula: SUM(), STDV(), MEAN(
SUM(p8)
Parameter Selector
Mo Selection %
New Remove
v
Compatibility Status
D Fix CCs - Cancel oK

Derived Parameters list. It lists the Derived Measurements to be carried out. Each Derived Meas-
urement is labeled with an ID (D1, D2,...) and requires a formula that entangles parameter IDs from the
Measurements List.

Name. This is the input field for setting the new Derived Measurement's name.

Formula. This is the input field for the algebraic expression that connects the desired parameter IDs
from the Derived Measurements List.

Parameter Selector. The parameters of the measurements list can be selected from this drop-down list
and their corresponding ID is entered in the Formula-field. Vice-versa if you select a parameter in the
formula field you get the corresponding parameter name displayed in the Parameter Selector field.
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Special Operators

@ It is possible that a number of individual Sub-objects of the same type can be identified with-
in the mask of a single individual Main Object. A set of statistical operators allows evaluating
individual parameters of the entire sub-object population of this type for the individual Main
Objects.

Statistical Operators:

e SUM(ID). This operator sums up all values of the given parameter ID of the sub objects for each main
object.

e MEAN(ID). This operator averages all values of the given parameter ID of the sub objects for each
main object.

e STDV(ID). This operator calculates the standard deviation of all values of the given parameter ID of
the sub objects for each main object.

e MIN(ID). This operator calculates the minimum of all values of the given parameter ID of the sub
objects for each main object.

e MAX(ID). This operator calculates the maximum of all values of the given parameter ID of the sub
objects for each main object.

e MED(ID). This operator calculates the median of all values of the given parameter ID of the sub ob-
jects for each main object.

e VAR(ID). This operator calculates the variance of all values of the given parameter ID of the sub
objects for each main object.

e [QR(ID). This operator calculates the interquartile range of all values of the given parameter ID of the
sub objects for each main object.

¢ MAD(ID). This operator calculates the median absolute deviation of all values of the given parameter
ID of the sub objects for each main object.

e AAD(ID). This operator calculates the average absolute deviation of all values of the given parameter
ID of the sub objects for each main object.

0 The parameter resulting from a special operator expression is assigned to the Main Object.

New. This allows inserting a new Derived Parameter definition into the list.

Remove. This deletes the selected parameter from the list.

3.8 Image processing

Images can be processed before being analyzed in an Object Finder Module. Thus, image quality can
be enhanced and the object detection improved and facilitated. A set of predefined image processing
modules is available.

A variable set of image processing steps can be assigned to each color channel. The configuration of
the individual steps takes place via the Image Processing window accessible via Assay » Edit Assay.
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Image processing changes the image data only temporarily! The original image data will not
@ be lost but remain stored. However, in the further course of the assay execution the analysis
will always work on the processed data. In order to keep the original data accessible during
the assay, virtual channels have to be created instead, see Chapter 3.9, Virtual Channels.
EX Assay Settings X
Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export
|I’TIEgE processors Image processor
| Madule | Channel |A Fs
BackgroundCorrection DAPI Module
-k BackgroundCorrection v
Color channel
Cy3 ~
Adjust
New Remaove
W
Image Selection for Module Adjustment  Wells Positions Timesteps
+ Reset All All All
Cornpatibility Status
D Fix CCs » Cancel OK

Image processors list. It lists the Image Processor Modules, i.e., the processing steps, to be applied
on the different Color channels of the images. The order of appearance in this list also sets the order of
execution. Moving the active entry up or down the list by using the arrow buttons changes the order of
execution.

Module. Select an Image Processor Module from this drop-down list.

Color channel. Assign a Color channel from the drop-down list to the active Image Processor
Module.

Adjust. Click here to open the Image Processing window for the active Image Processor Module.
New. This allows inserting a new Image Processor Module into the Module list.

Remove. This deletes the active module from the Image processors list.
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3.8.1 Background correction

For applications involving quantification of intensities and in case of inhomogeneities it is always rec-
ommended to use background correction. The algorithm implemented is an intensity-conserving algo-
rithm which ensures that the signals remain unchanged and can therefore be quantified (left image:
before background correction, right image: after background correction).

Filter size. This is the only parameter to be set.

For background correction a Filter size of 200 is the default value. For most cases when a

@ general background has to be removed it works fine. However, to better extract e.g. small
particles in the nucleus, a background correction filter size of 15 can be suitable (cf. exam-
ple below).
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E& Image Processing - b4
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0007--W0D001--P00D10--Z0D0DO--TOOD0D--DAPLtif
0007--W0D001--P00D11--Z0DOD--TOOD0D--DAPLtif v

Dark Background

Cancel oK

Example of small Filter size for background correction.

3.8.2 Smoothing

In order to use Smoothing IP go to the Image Processing tab or the Virtual Channels tab and press
New. Then select Smoothing from the Module drop down list. Click on Adjust in order to change the
settings of the IP. The Image Processing dialog opens. On the left the original image and on the right
the processed image is displayed. In the Images list on the left, the acquired image that is to be shown
in the displays can be selected. The sigma parameter allows you to adjust the smoothing.
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B Image Processing: Gaussian Smoothing - x

nalEle]
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The smoothing image processor

Applications: In some cases it may be necessary to smooth the image before object detection. This is
the case for

- noisy images,
- when the border of the objects is fuzzy,

— if the object detection algorithm splits one object in many small fragmented objects (see below).

D
o)

ol

Object detection without smoothing

Object detection with smoothing
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3.8.3 XY Shift

In certain cases it may occur, that image channels are shifted relative to each other in the channel over-
lay. This is rather often the case if an observation emission filter wheel is used and images are acquired
with different emission filters. This function allows correcting the shift along the X- and Y-axes.

XY Shift. Set here the number of pixels the chosen channel is to be shifted along the X- and Y-axes
relative to the other channels.

You have to control the result in the main user interface by pressing the Processed button. It is useful to
zoom into the image so that individual pixels can be detected visually.

3.84 Inversion

This function serves to invert the intensities of an image channel, i.e., to convert a channel into its nega-
tive image. This is necessary for example if objects are to be detected in transmission images. The ob-
ject detection tools of scan® are designed to detect bright objects on dark background. The situation is
reverse in transmission images. Thus they have to be inverted prior to the object detection.

Adjust Intensity. This defines the maximum intensity in the converted image. l.e., it is the intensity that
the originally darkest pixel will get in the converted image. 4096 is the default for 12 bit assays and cor-
responds to the maximum intensity in a raw image taken by a 12-bit camera. 65535 is the default for 16
bit assays and corresponds to the maximum intensity in a raw image taken by a 16-bit-camera.

3.8.5 CutImage

This module allows defining regions of interest inside an image and setting all image parts outside the
region to the intensity 0. Different drawing tools are available.

Ll Rectangle

Define a rectangle by mouse drag. Mouse dragging the center changes its position. The size can be
adjusted by dragging the corners.

<’| Rotated Rectangle

This is similar to the rectangle tool. Upon mouse-over its central axes are displayed. Dragging the ends
of the axes turns the rectangle.

- Polygon

Standard tool to draw polygons.
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& Freehand

Standard tool to draw freehand regions. The region is closed automatically once the mouse button is
released.

| Circle

Standard tool to draw circles. Close the circle by double click.

& Ring Segment

Standard tool to draw rings. Once a ring is drawn the inner and outer borders can be dragged to adjust
the thickness. The cutting line can be dragged to convert the ring into a ring segment.

3.8.6  Shading Correction

scan® Acquisition has a Shading Correction Manager for the acquisition of calibration images which
allow for correction of illumination inhomogeneities. If available, the relevant calibration images are al-
ways stored with the experiment data. With the Shading Correction image processor, the experimental
images can be corrected before further analysis if calibration images are available.
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3.8.7 2D Deconvolution

The 2D deconvolution module is an image processor which uses known experimental parameters (e.g.
numerical aperture, wavelength) in order to remove distortions introduced by the optical system in an
optimal way. Therefore, a physical model of the imaging system is estimated and deconvolution is ap-
plied to the image data with constraint iterative approach.

E& 20 Deconvolution - x

20482048 0.5% 16-bit image 31 (901,519) Tubereaty.chriincs 0 3 20482048 0.5% 16-bit image 4 (242,13) Jabe ey rpiny []
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~-WOD0D1 --P00004- -Z00DO2--TODODO--DAPI SEM.tif QEctive by o2 Edn g rizhale 8
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o
Status
[ o Cancel oK

The 2D deconvolution module requires additional information about the image data, called “metadata”.
The metadata usually is contained with the scan and automatically recognized by the 2D deconvolution
module. For using the metadata saved with the scan, select the Saved option close to the relevant
metadata. In cases where (part of the) metadata is not available with the scan or other metadata is sup-
posed to be used, the Edit options allows using manual settings. Usually it is required to set the Wave-
length manually because no information regarding the wavelength is saved with the scan data.

Once the metadata is complete, the deconvolution algorithm can calculate the de-convolved image and
display a preview. It might be necessary to try different settings for the number of Iterations used inter-
nally and to select if Adaptive PSF (point-spread-function) should be used.

The 2D deconvolution is a powerful image filter which can also be understood as a kind of optimal
sharpening filter. It can be very useful if segmentation of special features of the raw image data is diffi-
cult. Since the 2D deconvolution is working on 2D image data only, however, it is limited for fundamental
reasons. More sophisticated deconvolution strategies require a z-stack of image data which contains
significantly more information regarding light distribution along the optical axis.
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3.8.8  Z Projection

scanR Analysis is a 2D Analysis software. Many 3D applications, however, can be addressed very effi-
ciently by condensing information from (3D) z-stack data into (2D) projections. The Z Projection module
can be used to project the z-stack data only for Analysis and keep the complete 3D data for other pur-
poses. This is an alternative workflow compared to saving only the projections and not the complete z-
stacks during acquisition (see scan® Acquisition instructions manual for details).

The Z Projection module must be applied as first module to a Color Channel, i.e. no other Image Pro-
cessing module can be applied to the same Color Channel before the Z Projection module but only after
the Z Projection module.

3.8.9 3D Deconvolution

The 3D deconvolution module is an image processor which uses known experimental parameters (e.g.
numerical aperture, wavelength) in order to remove distortions introduced by the optical system in an
optimal way. Therefore, a physical model of the imaging system is estimated and deconvolution is ap-
plied to the image data with constraint iterative approach. In contrast to 2D deconvolution, 3D deconvo-
lution works on a z-stack of image data per position. This makes it possible to correct for out-of-focus
light in a much more reliable and precise way. On the other side, the calculation of the correction can
take significantly more computation time. Only one 3D deconvolution module can be used per color
channel and the 3D deconvolution must be the first Image Processor and Virtual Channel applied to a
color channel.

EZ 30 Deconvolution — x
7 Slice
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Images
~ . .
D000 --PD0D02- - Z00002- -TO00D0--TRITC SEMLtiF Image Metadata Settings Algorithm Settings Test Settings
~-WD0D01--POOD03--Z0DD02--TOD0DO--TRITC SEM.tiF : =
03 Edit [ 3 a
~-WO0001--PD0004- -Z00DO2--TOO0D0--TRITC SEM.tif Objective NA ! ftenticns rEns
--W00002--P00001--Z00002--TOR000--TRITC SEM.tif
~-WD0D02--POOO02--ZD0002--TODDDO--TRITC SEMLtif Refractive Index |1 Edit |~ Adaptive PSF Autematic [ ]
--WD0002--PODDC3--Z00002-- TOBODD--TRITC SEM.tif Update
--WD0002--POOD0S--ZDD002--TODDD0--TRITC SEM.tif Picel Spacing [um] |0.645 | Saved | Output| Max projection v
Z Spacing [um] 08 Saved |v Limit Input Slices  Use All ~
Wavelength [nm]  |570 Edit [

Status
ok Cancel 0K
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The 3D deconvolution module requires additional information about the image data, called “metadata”.
See the documentation for the 2D deconvolution module for details on metadata. The 3D deconvolution
module requires one additional piece of metadata, the z-spacing. In addition to the number of Itera-
tions and whether to use Adaptive PSF (point-spread-function), the 3D deconvolution algorithm re-
quires the selection of the Output image. While the input will always be a z-stack for each position, the
output will be a single image which can be either the in-focus slice, or a projection of the output z-stack.
In order to reduce processing times, the Limit Input Slices functionality allows selecting a subset of the
original z-stack as input.

Calculation times can be in the order of many seconds to minutes, depending on the size of the input
image data and the algorithm settings. For this reason the preview image will only be updated if the
Automatic Update option is selected. If this option is not chosen, pressing the Execute button once will
update the preview windows when the input image or the Algorithm Settings have changed.

The original image stack as well as the output image stack can be browsed by using the Z Slice slider.
The slider indicated the in-focus slice as well as the used range of input slices. By setting the slider, a
particular z-slice can be selected and the effect of the 3D deconvolution can be judged. The View Pro-
jection button toggles the output display between the processed z-stack which can be browsed with the
Z Slice slider and the output of the 3D deconvolution module as defined by the Output control.

The 3D deconvolution module must be applied as first module to a Color Channel, i.e. no other Image
Processing module can be applied to the same Color Channel before the 3D deconvolution module but
only after the 3D deconvolution module.

3.9 Virtual Channels

Virtual channels are image channels that are not created via image acquisition during the execution of a
scan. Instead they are a result of post-acquisition image processing and added as new channels to the
original image data. These can then be used for further analysis steps, e.g. object detection.
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@ Assay Settings
Main Object

VC Process List

Sub-objects

Parameters

Derived Parameters

Image Processing

Module

-~

Input Channels
DAPI
Cy3
DAPI
DAP

+ Reset

D Fix CCs

Virtual Channels

~ DAPI_unmixed
v Cy3_unmixed
~ not used

Image Selection for Module Adjustment  Wells

All

Cormpatibility Status

Virtual Channels

Maodule
SpectralUnmixing

Adjust

Positions
All

Cancel

Image Export

Remove

Timesteps
All

oK

New. Click here to create a new entry in the VC Process List.

Chapter 3 — Assays

Virtual Channels list. Default names for the virtual channels resulting from the processing are automati-

cally created. It can be changed manually.

Remove. Click here to delete the active entry from the VC Process List.

Module. Background Correction, XY Shift, Inversion, Cut Image, etc. are the same functions as
described in Chapter 3.7, Image Processing.

Adjust. Click here to open the dialog of the selected module.

3.9.1

Simple Math

The Simple Math module serves to perform calculations on the image through basic arithmetic opera-

tions: addition, subtraction, multiplication and division.

Module. Select Simple Math from the Module pull-down list to set this module as active entry in the VC

Process List.

Input Channels list. All color channels of the images are possible Input Channels for the Simple Math
module. The channel selected as first Input Channel is always the first source of the arithmetic opera-

tion. The other channels are possible second sources.

Adjust. Click here to open the Simple Math dialog. It contains displays of the overlay of the Input
Channels and of the Virtual Channel that is created by the selected arithmetic operation.
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@ Simple Math - x
Display
Input Channels (DAPI + Cy3)

0 2
o o
ol o
I134-dx1DZdTX32-b|tRGE\mage},}d,} (1076,771) | Intensity clipping 0.01 : |1344xwz41x1a-mt.mage3599 (422,8) Intensity clipping 0 :
Settings Paosition List
-~
P e o B1--W00D13--P00D03--Z00000-- TOO00D--DAP!.tif
B1--W00013--PO0004--Z00000--TOD000-- DAP! 4if
- B1--WO0013--PODD0S--Z00000-- TOD0DD--DAP! tif
Channel 1 Channel 2 Channel 3 B1--W0D013--P000DG--Z00DO00-- TDOOOD--DAP| tif
1E+1 1E+1 4 1E+1 B2--WODD14--PODDN --Z00000--TOD0DD--DAP! tif
; B2--WODD14--PODD02--Z0D0DD-- TODODD--DAP!.tif
g 8 8 B2--WO0014--PO0003--Z00000-- TOO00D--DAP tif
3 . . B2--WODD14-- PODD04--Z00000-- TODODD--DAP tif
0430 15 100 5 - 00 5 B2--W00014--PO0D05--Z00000-- TOO000--DAP tif
4 2 p B2--W00014--PO0006--Z00000--TOD000-- DAP! if
B3--WODD15--PODDD1--Z0D00D-- TOD0DD--DAP! £if
2 2 2 B3--W00015--PO0D02--Z00000-- TOO00D--DAP if v
o & 0 0
Cancel QK
Settings

Channel 1, 2, 3. Each of the Input Channels can be weighed prior to the arithmetic operations by using
the sliders or entering a multiplication value between 0 and 10 into the respective boxes.

Arithmetic operations selectors. Select the operation (+, —, %, +) that is to link Channel 1 and Channel
2 from the first pull-down selector (e.g. DAPI+FITC). Select the operation that is to link the result of
Channel 1 and 3 with Channel 3 (e.g. (DAPI+FITC)xTxRed) from the second pull-down selector. Select
Skip to deactivate Channel 2 or Channel 3, respectively.

39.1.1 Example: Cytoplasm not detectable on a single color channel
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In this example it is not possible to detect the cytoplasm on a single color channel because the area of
the nucleus has very little cytoplasmatic staining:

Problem. The detection is incomplete because staining is missing on the nucleus area.

Solution. The nucleus staining and the cytoplasmatic staining are added as VC.

s et AMCEEITIT 32690 gt + 354 )

Result. Full Cell Segmentation of the complete cell can be performed on the calculated new channel.

3.9.2  Spectral Unmixing

A major problem in live cell imaging arises from the use of different fluorochromes with overlapping
spectra in one multi-labeled sample, impairing a number of applications. Even with the use of high quali-
ty optical filters it is not satisfactorily possible to separate the spectral information. The consequence is
the excitation and imaging of structures that are labeled with one of the present fluorophores when using
a filter set that is actually chosen to excite and image another fluorophore.

With the Spectral Unmixing module it is possible to separate and resort the contribution of different
fluorochromes to the total signal in each color channel and redistribute the different color intensities. It
thus improves the spectral resolution of the channels considerably and facilitates for example co-
localization studies.

Get from ROI. Takes the mean value within the marked region as Stain/Background.
Ignore Stain. Click here to ignore the third channel in order to properly unmix two-channel images.

Background. Spectral Unmixing yields quantitatively meaningful data only if a background subtraction is
performed prior to it.
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= 3:3 Spectral Unmixing — x

Js)
V]
=l
[132461024 0.5 32-bit RGB image 12.22 (996,526 Intensity clipping 0 3] [1244x1024 05K 32-bit RGE image 300 (130.232) Intensity clipping 0 .
Stain Selection: Stain Slope Control Status Position List
o oK B2--W00012--P00002--Z00000--T0DO0D--DAPIif ~
B2--WW00014--P00003--Z00000-TODOOD--DAPIif
D B2--WW00014--P00004-ZDD000--TDDOOD--DAPIif
Show Details B2--W0D014--P00DDS--Z00000-- TODDDD-- DAPLtif
Stain 2 o B2--WW00014--P00DDG-~Z00000-T0DO0D--DAPL.tif
o ) 'B3--WO0015--PO0DD1--Z00000--T00000--DAPL.&f,
] u Setti
. |:| GetfromROl | o e B3--W00015--P00002-~Z00000--T00000-- DAPL.&if
g ) B3--WW00015--P000D3--Z00000-T0D00D--DAPL.tf
Stain 3 5 Transformation Matrix B3--WW00015--P00004-~Z00000-T0D00D--DAPLtif
omien E b7 o7 |ose B3--WW00015--P000DS--Z00000--TODOOD--DAPL.tf
e £ e B3--WW00015--PC000S--ZDD00C--TDDOOD--DAPIif
L .| B4--WW00016--P00001--ZDD00C--TDDOOD--DAPIif
Background poo_|poo a3 B4--WO0016--PO0002- -ZD0DDC- - TDDDDD- - DAPLEF
B4--WW00016--PC0003--ZD000C--TDDOOD--DAPIif
Ea(kgruund RA..WNNN1A-. PANNNAA. . 70NNNN. . TRNNNN. . NAD| +if v
B3 |Bz [0

Input Channels 12

Cancel 0K

Show details. Displays the matrix created by the selection of the stains. This matrix is used for the pro-
cessing of the images. The entries of the matrix can be changed manually. A graphical representation is
displayed.

Output channels. Select the stains to see the result of the spectral unmixing.

1. Inthe Module drop-down list select Spectral Unmixing and press New.

2. Press Adjust to start the 3x3 Spectral Unmixing dialog.

3. Click on the Background button.

4. Mark a background area using the drawing tool (button on the bottom right corner of the im-
age displays).

5. Click the Get from ROI button.

6. Identify a structure that contains just the first fluorophore.

7. Mark the structure using the drawing tool (button on the bottom right corner of the image
displays).

8. Click on the Stain 1 button.
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9. Click the Get from ROI button.

10. Repeat steps 6 — 9 for the other fluorophores (stains).

In order to perform the spectral unmixing the software has to determine the contribution of
the fluorescence of different fluorophores to the different color channels. To do so, ideally
series of mono-labeled reference samples would be used. In case such samples are not

@ available for each of the fluorophores, molecular structures have to be identified by the user
that are certain to contain only one of the fluorophores and that do not spatially overlap with
structures containing other fluorophores.

The result of the spectral unmixing is shown in the right display of the 3x3 Spectral Unmixing dialog.

Unmixing dual-labeled samples. In the case of two-channel images the third input channel
will be occupied by one of the two available channels. Click Ignore stain to ignore the third
channel in order to properly unmix two-channel images.

3.9.3 Neural Network Processing

The Neural Network Processing module is used to apply any neural network to one channel or a com-
bination of multiple channels. The neural network is used to perform predictions of objects (for example
cells or subcellular compartments or other) in the images according to its training. The processing result
output is a new Virtual Channel that contains the probabilities that the objects to be predicted are at a
particular location within the image.

When selecting the Neural Network Processing module, a new drop-down list becomes available which
allows selecting a Neural Network by its name. Once a neural network is selected, the number of input
channels (one or multiple) required for this neural network are enabled, and a Description of the select-
ed neural network is shown.

Multi-channel neural networks. Many neural networks operate on a single input channel.
For more complex analysis tasks, however, it can be necessary to employ neural networks
which are trained to work on multiple channels at the same time. This will be indicated in the
Description, and it is required to provide the correct order of input channels according to the
description.
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Z-stack neural networks. Many neural networks operate on a 2D (single z-layer) input

@ channel. For more complex analysis tasks, however, it can be necessary to employ neural
networks which are trained to work on z-stack data. This will be indicated in the Description,
and it is required to provide an input channel with sufficient z-stack data for correct predic-
tion.

o Neural Nety

. ZSlice  Prediction

& G,

BF - |2043x2043 0.5X 13475 Intensity clipping 1

Position List
A1--WODDO1--PO0DD1--Z00000-- TOODOD--EF Aif ~|  Pixel Spacing [um] 065 0565
A1--WODDO1--POODD2- - Z0000D-- TOODOD-- BF Aif
A1--WODDO1--POODD3--Z0000O-- TOODOD--BF Aif
A1--WODDO1--POODD4--Z000DO-- TOODOD--BF Aif
A1--WODDO1--PODDDS--Z0000D-- TOOD0D--BF Aif
A1--WODDD1--POOOD6-Z00000--TO000D--BF.if 2 Te=(im)
—-\WOODO1—-POO0D7--Z0000D--T0DD00—BF i
A1--WODDO1--PODDDE--Z0000D-- TOODOD-- BF Aif BF 0 0
A1--WODDO1--PO0DDI--Z0000O-- TOODOD--BF.Aif
A2--W00002--P00001--Z00000-- TOOD0O-- BF tif
A2--W00002--P00002--Z00000-- TOOD0O- - BF tif
A2--WODDO2--PODDO3--Z00000- TOOOD--BF Aif
47 wWAnaNs Bonnad_7Annne Thennn BE s

Status

D Ok oK

All objects - |2msx2msnﬁst Intensity clipping 1

Neural Network Scan

Bitdepth 16 16

3.93.1 Example: Detection of nuclei in bright field channel

If, for example, it is required for an assay to detect nuclei in transmission bright field images, the best
solution might be to solve this task using a neural network. A typical image of the input channel might
look like shown in the following figure.
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A neural network trained to find nuclei in bright field images can predict for each pixel of the image the
probability that this pixel belongs to a nucleus. The probability result, a map of the size of the image, is
provided as a new virtual channel and can be used for object detection. Furthermore it can be used in
the main Image Viewer (see Chapter 2.5, Using the Image Viewer) like any other virtual channel and
displayed as one channel of the combined multi-color image.
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3.9.3.2 Detection and Classification

There are two different kinds of neural networks available with scanR. Depending on the training, a net-
work can detect objects of a single class (for example, nuclei), or it can detect and differentiate multiple
classes of objects (for example, nuclei undergoing mitosis and nuclei not undergoing mitosis).

Single class detection networks have a single pair of Virtual Channels as output of the Neural Network
Processing. The output consist of one objects map and one one probability map which can be used for

object detection as any other image type.

Input Channels

Trans

[

Trans
Trans

Trans

kv

L3

W

Virtual Channels

Muclei Objects

Muclei Prebability

OLYMPUS
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Classification networks have multiple Virtual Channels as output of the Neural Network Processing.

Input Channels Virtual Channels
Trans w Mitotic Objects ~
Trans MNen-Mitotic Probability
Trans Mitotic Probability
Trans Classification

The different output channels have different functions:

e The All Objects channel enables direct detection and segmentation of all objects, independent
of their class.

e One probability map for each class separately.
e The Classification channel contains all objects with their respective classification, coded in im-
age gray values (class 1 = gray value 1, class 2 = gray value 2, ..).

For details and descriptions of the typical classification workflows see Chapter 6, scanR Al.

3.10 Image export

The Image Export tab allows selecting one or more (processed) color channels which will be exported
during analysis.

@ Assay Settings x
Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Output Channels Color channel
Channel A Cy3 ~

SpectralUnmixing_DAPI

New Remove

Processed Image Buffering

Cormpatibility Status

D Eix CCs - Cancel OK
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Technically, a new folder "processed" will be created next to the original "data" folder. As soon as analy-
sis of the data has finished, the "processed" folder contains the processed images of all selected color
channels. When available, the saved, processed images will be used when browsing the analysis results
to optimize speed of visualization and avoid unnecessary and time-consuming re-processing. Pro-
cessed Image Buffering automatically adds Color Channels to the list which are using with time-
consuming image processors, for example 3D Deconvolution.

3.11 Image selection for module setup

Setting up a new assay or optimizing assay settings often requires changing parameters of object detec-
tion or image processing steps using the “Adjust” buttons. The module windows then provide a list of all
images at all wells, positions and time steps so that parameters can be adjusted with direct control of the
effect.

Images

B1--W00013--P00D03--Z00000--TO0000--DAPLEIF
B1--W00013--P0000--Z00000--TO0000--DAPLtf
B1--W00013--P00005--Z00000--TO0000--DAPLtf
B1--W00013--P0000G--Z00000--TO0000--DAPLtf
B2--W00014--P00001--Z00000--TO0000--DAPLtf
B2--W00014--P00002--Z00000--TO0D00--DAPLLf
B2--W00014--P0O0D03--Z00000--TODD0D-- DAPLtIf
B2--W00014--P0O0D04--Z00000--TOOD0D-- DAPLtF
B2--W00014--P0O0D05--Z00000--TO0000--DAPLEF
B2--W00014--P0O0D0G--Z00000--TO0000--DAPLEF
B3--W00015--P0000T--Z00000--TO0000--DAPLL

The list of all images can be long and sometimes it is useful to reduce it with the Image Selection for
Module Adjustment filter. For example, only the positive and negative control wells or only the first time
step or a few position from each well can be selected to have the possibility to set up the modules with
the most relevant images. In this example, only position 3 in each well is selected.

Add te list

Image Selection for Module Adjustment  Wells Positions Timesteps
Reset WO000013 - B1 A P0O0OD1 A TO0O0DD A
WO00014 - B2 POD0DOD2
W00OD15 - B3
WOD0D16 - B4 POD00D4
WO00017 - B3 PO0D00DS
WO000018 - B& POD00DG
W000019 - B7 v v v

Compatibility Status

il |Fccs % Cancel oK

This will result in a reduced list of images in the module windows, only listing images from the 3™ posi-
tion for each well.

Images

B2--W00014--P00003--Z00000--TO0000-- DAPLtf
B3--W00015--P00003--Z00000--TO0000--DAPLtf
B4--W00016--P00003--Z00000--TO0000-- DAPLtf
B5--W00017--P00003--Z00000--TO0000-- DAPLtf
B6--W00018--P00003--Z00000--TO0000--DAPLtf
B7--W00019--P0O0003--Z00000--TO0DD0--DAPLEIE
B&--W00020--P0O0003--Z00000--TO0DDD--DAPLEE
C1--W00025--P00003--Z00000--TO0000--DAPL.tif
C2--W00026--P0O0003--Z00000--TO0000--DAPL.tif
C3--WO00027--P0O0003--Z00000--TO0000--DAPI.tif
C4--W0D028--P00003--Z00000--TO0000--DAPL.tif
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Once the selection has been done, the filter can be folded up such that only the summary (which well,
positions, timesteps are used for module adjustment) is shown.

Image Selection for Medule Adjustment  Wells Positions Timesteps
+ Reset All 2 All

Compatibility Status

D Fix CCs - Cancel oK

0 The filter is not part of the assay and hence not saved with the assay. It is only used during
assay setup as convenience tool. This has no effect on the analysis itself.

3.12 Kinetic — analyzing time-lapse data

The tracking function of scan® Analysis allows the analysis of objects over the course of time, i.e., in
experiments that consist of time-lapse acquisitions. It relates any object detected in an image to the
same object in the previous and subsequent images in the time-lapse series acquired at the same stage
position. Thus the change of the parameters that are measured according to the assay settings can be
followed over the course of time.

To enter the Trace View select Trace in the lower left part of the front panel or in the menu bar, select
Kinetic » Trace view. The front panel display changes such, that the displayed objects change from
Main to Trace and also the available X/Y-parameters in the histograms are changed according to the
parameters that are defined in Kinetic » Define Parameters (See Chapter 3.12.2.1, Original parameter-
S).
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= scan Analysis: GFP-+mRed_001_Traced6 jp2

Analysis Scan Kinetic View Modules Repositioning Preferences  About

1000 1200 1410 . 1000 500 00

lifetime w 290E+1 Counts Object X max(Der(Area)) w 3.65e+0 Counts Object X | max(Meanintensity(GFP)) w 1.11E+3  Counts
lifetime w 2.90E+1 Trace - v MaxMinAreaRatio w 4.09E+0 Trace w v mean(Meanintensity(GFP)) w 1.05E+3

TxRed w

DPFGCE;EEd

Image

Row

B
Column & oo 200 40 § n 00 1200 1400 .
Position Lk &

: K 1
Time

8 HE

Object X [t_max(Meanintensity(GFP)) w 7.20E+1  Counts
Trace w v t_max{(Meanintensity(GFP)) w 7.20E+1

Selected Wells.
Interactive objects

Main -
R —— o DMa\'n Display

Analysis Progress

1X  (400,18) FOV: 217.0x165.4 um Well Name / Description B3

When clicking on one tracked object in the image now not only the object is highlighted with a green
border but also the trace it covered during acquisition will be displayed. With time the object moves from
the blue end of the line to the red end. Like in the Population View the detected object and the corre-
sponding data points in the histograms are directly linked.

Right-clicking on an object in the image yields the following context-menu:

/ Show Selection

Show Trace

Gallery

Movie

Save as...
Copy

Show Gates. It has the same function as in the population view. When you select a gate from the list,
the objects that fall into the gates are marked with a box in the front panel image.

Show Selection. Enables or disables if cell outlines and traces of selected cells are displayed.

Show Trace. This opens the Trace Viewer which displays the time curve for the selected object. (See
Chapter 3.12.3, Trace viewer)
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Gallery. This command displays a time-gallery of the selected object.

EE Meain: Circularity Factor, Circularity Factor - m] x

vlelvls/@@la s Fo
wlefelv/o@lnn Fs
wlelo|v]o@lan(rle
wlefs]v/0al®lniFe
[wlefe]v[o0/@b|Fe
[wlelelvipio|@n|Fe

1800x800 12

Gallery display in time-lapse mode

Movie. This opens the dialog Trace Movie which allows you to export a movie of a single trace or a
complete image (position).

Save as ... This allows you to store the displayed image separately.

Copy ... This allows you to copy the displayed image into the clipboard for pasting in other software.

B image Movie x
Compression Filter
DV Video Encoder
Frames/s
Save as...
Ch\Users\WoerdemaMi\Desktop\GFP.avi =
Progress
I
Generate Cancel
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3.12.1 Tracking configuration

The Kinetic » Configure Tracer command opens the Tracker Settings window. It also opens automat-
ically when the View mode: Trace is activated without any tracking parameters being set already.

Tracked Object Type. Select here the kind of objects to be tracked, i.e. main objects or any of the sub-
objects — if such are defined in Assay Settings » Sub-objects. (See Chapter 3.4, Sub-object finder:
detecting sub-objects)

EZ Configure Tracer X

Enable Tracking

Tracked Object Type
Main Object o

Range (Pixel)

I 20 5

Cancel oK

Range (Pixel). Set here the maximum difference that is allowed to change between two frames in order
to maintain a track. If the difference exceeds the Range an object will NOT be related to similar objects
in the previous and subsequent images of the time-series.

OK. Click here to start the tracking. The progress can be followed in the status bar at the bottom right
corner of the scan® Analysis main interface.

I:‘ Main Display

Pause

3.12.2 Track analysis parameters

During the tracking, not only the X/Y-positions of an object over time are calculated, but also the time
course of the parameters previously determined in Analysis » Assay Settings... » Parameters (see
Chapter 3.6, Measurement parameters) is extracted of the data. The curves for each individual object
are displayed in Kinetic » Define Parameters... » Original Parameters. This dialog allows defining
which kinetic parameters of these curves are extracted, e.g. the maximum intensity, the time of maxi-
mum intensity or the duration of an increase in signal.
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3.12.2.1  Original parameters

Open the Define Kinetic Parameters » Original Parameters window directly via Kinetic » Define Pa-
rameters.... At startup it shows the kinetics graph of one of the measured parameters of the first track in
first stage position of the first well acquired and selected for analysis. (See Chapter 2.7 Interactive plate
result view.)

To navigate through the curves use the Well, Position, and Trace selectors on the right. Each Trace
represents the object in subsequent time frames that the tracer, according to the settings in Kinet-
ic » Configure Tracer detected as belonging together. In the Original Parameters tab you can set the
Operators that are applied to the time curves to quantify the time curves. By applying an Operator (min,
max, std, first, etc.) the time curves again are reduced to single values per curve that in turn can be
displayed in a 1-D or 2-D histogram. For example when Totallntensity(TxRed) was selected in the
Parameter tab of Assay Settings, the time curve of Totallntensity(TxRed) can now be plotted. By
applying the Operator max on this time curve, for all traces the maximum of Totallntensity(TxRed) will
be calculated.

m Define Kinetic Parameters X
Original Parameters Derived Parameters
1271.358- Well
1250~ 15 v
1225- Position
1200- 1 =
175~
Trace
g 1150~ 19 -
= 1125-
‘;F 1100~
]
I 1075~
= Add Range
ﬁ 1050-
= 10s- Add Threshold
992.059-, | | | | ' ' | | | | | ' \ \ Remove
0 0 20 EL ] 50 60 78 % 100 10 120 130 140
Absolute time
Derivative
Parameter Mean Intensity (GFP) w
Smoothing (sigma) '
0.01 0.1 1 15
Definitions MName
Name Operator Result ~ first(MeanlIntensity(GFP))
mean(Meanlintensity(GFP)) mean 1088 Operator
meaniArea) mean 1230 first ~
min(speedofmotionX) min -1.121
max(speedofmotion') masx 0.727
t_max(Meanintensity(GFP)) t_max 109 Advanced
lifetime lifetime 141
max(Der(Area)) max 43.41
max(frea) max 1669 Mew REmare
—irA == Zin b
Compatibility Status
Cancel oK
0K ~

Trace parameters.

Well, Position, Trace. You can navigate through the set of curves using these functions and their arrow
buttons.

Add Range. Click here if you want to analyze just a part of the trace. Two vertical blue bars appear in
the graph to define the upper and lower limit of the range. They can be moved via mouse-drag. The
analyzed part of the curve is displayed solid. The remaining part is displayed as a dashed line. Click
Add Range several times to create multiple ranges.
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Qriginal Parameters Derived Parameters

1034671 ; well
N 15
1030- lz‘

z Position
1025~ =]

1
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Three ranges applied to a trace
Add Threshold. Click here to open a dialog which allows you set an upper or lower bound for the curve.

A blue bar appears that marks the upper or lower part of the curve, respectively. The bar can be moved
via mouse-drag.

Remove. Click here to remove the Range limits.

Parameter. Select the measurement parameter of which the time curve is to be shown in the graph
display.

Derivative. Check this option to calculate and display the first derivative of the kinetics time curve of the
selected Parameter.

Smoothing (Sigma). This function applies a smoothing filter on the track data. Set the strength of the
smoothing with the slider. The graph display is being updated immediately.

Definitions. This lists the names of the values to be determined from the curves as well as the opera-
tors used. In the Result column the values for the selected trace for all parameters are listed.

Operator. Select an operator from the drop-down list. This will be applied on the currently selected Pa-
rameter. For example, if mean is applied on the Mean Intensity of the tracked objects the time average
of the mean intensity of each object will be calculated.

The available Operators are:

- Lifetime. Gives the number of contiguous time points the particle is detected
- Sum. Calculates the sum of the parameter value over the time

- Mean. Calculates the mean value of the parameter

— Min. Takes the minimal value the parameter reaches

— Max. Takes the maximal value the parameter reaches

- Std. Calculates the standard deviation of the values

- First. Takes the value of the parameter at the first point of the curve

- Last. Takes the value of the parameter at the last point of the curve
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— T_max. Takes the time point when the parameter is maximal

- T_min. Takes the time point when the parameter is minimal

-  T_first. Gives the time point when the trace starts

— T_last. Gives the time point when the trace ends

- Num_zero_crossings. Gives the number of zero crossings of the curve
- Num_local_max. Gives the number of local maxima of the curve

- Num_local_min. Gives the number of local minima of the curve

Name. The name of the analysis function is set automatically as <Operator>(Parameter). It can be
changed manually.

New. Click here to create a new list entry.
Remove. Click here to delete the selected list entry.

Advanced. Click here to show advanced options. The Derivative checkbox will be replaced by a list that
allows you to apply Anti(-)/Derivatives(+) of higher order. In the Operator drop-down list a new option
becomes available: the curve-fit.

Curve-fit. This Operator allows you to fit certain models to the parameter curves. Upon selecting curve-
fit from the Operator drop-down list the Define-button becomes accessible.

Define. This opens a dialog to set the options for curve fitting.

As objects might move in or out of the focal plane, or the value entered for Range might be
set too small, there might be a large number of short traces. Therefore Lifetime is a useful
parameter as it allows setting a gate on long traces.

3.12.2.2  Curve fitting

Model type. Select the type of model that is to be fitted to the curves. You can select Polynomial, Ex-
ponential, General Is linear and non linear.

Polynomial. The only parameter to be set is the Polynomial order. E.g., the model function is
f(t)=ao+a1-t+a--? for Polynomial order of 2. In this example the parameters ao, a1 and a. are fitted to the
curves.

Exponential. No parameters have to be set. The model function is f(t)=a-exp(ct). The parameters a and
c are fitted to the curves.

General Is linear. General linear least-squares fit. Here you can enter arbitrary Basis functions (linear,
exponential, trigonometric,...) which will be combined linearly. E.g. set fi(t)=17-t+4 and f2(t)=exp(-
(t+2))*2 will be combined linearly to f(t)=ao- fi(t)+ ai- f(t)= ao (17-t+4)+ a1~ exp(-(t+2)"2). This function
represents a linear combination of a line and a Gaussian. The parameters ao and a: are fitted.

Non linear. Here you can enter an arbitrary model function to be fitted with up to 6 parameters. You
have also to enter the start values as First guess. E.g. if you want to fit a Gaussian you set
f(t)=a-exp(-(t-b)?/(2c?)) and enter start values for a, b and c. You can also set the number of iterations to
be run by entering a value for Max iterations.
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B Curve fitting x

Model type
Mon linear ~

Parameter ~ First guess

a 1

b 2

c 3
Model to fit

fit) = |a*ep(-{t-b)*2/(2*c"2))
Max iterations

40 =

Model Status
a*exp(-(t-b) " 2/(27c"2))

The parameters that are fitted (e.g. ao,, a1,...) and the mean squared error of the fit (mse) are listed in
the derived Parameters tab in the following representation: curve_fit<modelfunction>(Parameter).a0,
curve_fit<modelfunction>(Parameter).al, ..., curve_fit<modelfunction>(Parameter).mse.
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3.12.2.3 Derived parameters

B Define Kinetic Parameters X

Original Parameters Derived Parameters

Original Parameters

Id Name A

pl mean(MeanIntensity(GFP))
p2 mean(Area)

p3 min(speedofmotionX)

pd max(speedofmotion')

p3 t_max(Meanintensity{GFP))
p6 lifetime

p7 max(Der(Area))

[ max(frea)

p9 min(Area)

p10 | min(Meanintensity(GFP))
p1l max(Meanlntensity(GFP])
p12 [ mean(speedofmotionX)

p13 | curve fita

RETI R

Derived Parameters Name
Id Mame Formula ~ MaxMinAreaRatio
Formula
p&/p9
Remove New
v
Compatibility Status
g oK > Cancel oK

The Define Kinetic Parameters » Derived Parameters tab allows to perform calculations with the pa-
rameters listed in the Definitions list described above by the use of basic algebraic expressions (+, -, X,
+, sgrt, ® etc. For a complete list, see Appendix 7.5).

Original Parameters. This is the list as created on the Original Parameters tab and includes also the
fitted parameters when the operator curve_fitting is applied.

New. Click here to create a new list entry.

Name. Set the name of the new Derived parameter here.

Formula. Set the formula here using the ID of the original parameter(s) and the algebraic expression.
Example.

Imagine you want to measure the change of cell size. The Original Parameters needed are thus the
maximum (max) and the minimum (min) of the parameter Area. The formula for the Derived Parameter
would thus be p8/p9 (assuming parameter definitions as shown in the figure), yielding a growing factor.
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3.12.3 Trace viewer

Open the Trace Viewer by selecting Kinetic » Show Traces in the main menu. Alternatively you can
right-click on one detected object in the image while in the Trace View and select Show Trace to see
the trace of this individual object. Set the number of displayed traces with the slider on the right. To dis-
play only objects of a certain gate that was previously defined in the Trace View this gate can be select-
ed in the Gate drop-down list.

The results of the tracking are displayed in the Trace Viewer once the tracking has been executed.

Max displ. traces. Use the slider to adjust the number of displayed traces. The traces will be taken from
a random selection of the specified gate.

Single mode. Use this option to have just one trace displayed. If a trace is selected via mouse click it
will be this one that is being displayed.

Gate. Select a gate to have only the corresponding traces displayed.

Time Scale. Absolute Time is the default and causes that each point in time is set relative to the begin-
ning of the time-lapse series. Each point in time is set relative to the beginning of each track when t_first
is selected, which may be important if an object was not tracked right from the start of the time-lapse
series and one is interested especially in the data at the beginning of each track. Alternatively, when
applying the operator t_max e.g. on the parameter Meanintensity(GFP), the time point when the mean
intensity of GFP is maximal is set to be 0. This way the time curves can be displayed “synchronized”.

ﬁ Trace View 4

1349.0- Gate

1325.0- Mitotic ~
1300.0-
1275.0-
1250.0-

Maz. displ. traces

1000

100

1100.0 - <=
10?5.0—_’J i

1050.0-=
:

T Single mode

998.5-, i .

I I 1
-100 -80 -60 -40 -20 ] 20 40 60 80 100

t_max(Meanlntensity(GFP))

Time scale t_max(Meanlntensity(GFP)) “| Derivative
Parameter Mean Intensity (GFP) ~ O

Smoothing'
sigma) o1 0.1 1 10 15

Parameter. Select parameter of which the time curve is to be shown in the graph display.

Derivative. Check this option to display the first derivative of the curve of the selected Parameter.
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Smoothing (sigma). This function applies a smoothing filter on the .time curve. Set the strength of the
smoothing with the slider. The graph display is being updated immediately.

Selecting objects and navigating along tracks: Tracks in the Trace View and the objects
in the images they derive from are directly linked. Upon clicking on a time curve the corre-
sponding image with the marked object will be shown in the image display of the main scan®
Analysis window. Also the data points marked with a red circle in the histograms are linked

@ to the time curves. Likewise, upon clicking on an object in the image display or in a scatter
plot the corresponding time curve will be shown in the Trace Viewer.

A dashed vertical line marks the current point in time in the Trace Viewer. Upon moving the
cursor left and right while keeping the mouse clicked one can thus scroll back and forth
through the "movie" of the time-lapse series.

@ Trace View st
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3.12.3.1 Set trace viewer scale

OLYMPUS

A right-click on the plot that is displayed in the Trace Viewer opens a context menu where you can se-

lect Properties.

@ Trace View
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The Trace Viewer Properties dialog opens. Here you can set the X and Y scale of the histograms.

EX Trace Viewer Properties

Autoscaling| growing v

Hscale Y scale
Minimurm 0 Minimum 1027.11
Maximum 140 Maximum 1349.01
log[] log ]

Autoscaling ~ growing v

Cancel

x

Minimum: Sets the minimal value of the x- and y-axis, respectively.

Maximum: Sets the maximal value of the x- and y-axis, respectively.

Log: Check this box for logarithmic scaling of x- and y-axis, respectively.

Autoscaling: Choose between three autoscaling methods:

- off: no autoscaling. The scale remains fixed when different curves are displayed
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- growing: the scale will increase if the current scale is not large enough to display all data points
of the selected curve(s) but it will not decrease if the selected curves do not fill the complete his-

togram.

- compact: the scaling is optimized to display fit the selected curves optimal into the histogram,
i.e. the display is chosen such that the max and min values of the curves are also the maximal
and minimal values of the histogram.

A right-click in the Trace Viewer gives also the option Rescale. This option can be used to scale the
currently selected curves optimally in the histogram without changing the settings of the autoscaling
when further curves are added.

3.12.3.2 Export trace view data

Trace data can be exported by right-clicking in the Trace Viewer and selecting Export Data. This com-
mand opens a file explorer dialog where a location for an export file can be defined. A name for the file
will be suggested which indicates the parameter for which it contains data. The file is a text file where
multiple columns are separated by tabulators. While the first column contains the time index, the follow-
ing columns contain the data of the trace(s) visible in the Trace Viewer.
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4 Analysis Results

This chapter describes how an analysis is executed, how the results can be grouped into object popula-
tions and how these can then be analyzed and statistically evaluated.
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4.1

Running an analysis

Execute Scan » Open... and select the experiment_descriptor.xml file in the storage folder
of the scan. By doing so the experimental settings are loaded and the first image of the scan
(taken at the first position of the first well) will be displayed. If you want to modify or revisit an
analysis execute Analysis » Open... instead.

Execute Analysis » Load Assay... to read in a *.say assay file stored in the scan® Analy-
sis/Assays folder. If you want to modify the assay file of the current analysis execute Analy-
sis » Assay Settings... instead.

Set or modify the parameters in the assay as described in Chapter 3, Assays

If you want to perform the analysis on a subset of the wells, open the Plate window via
Scan » Plate... and select the wells of interest.

In order to observe the analysis results online prepare the four histogram windows by select-
ing the objects and measurement parameters to be displayed.

Click the Run button (or execute Analysis » Run) to start the analysis. You can follow the
progress of the analysis in the window at the bottom right of the main scan® Analysis inter-
face.

DMain Display

Analyser

The window shows the Analysis Progress and displays the image that is currently being
analyzed in the thumbnail display. Click the Main Display button to have this image displayed
in the main image window. You may Pause or End the analysis by clicking the respective but-
tons.

Once the analysis is completed store the results via Analysis » Save as...
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4.2 Managing gates

scan® Analysis detects objects in all images acquired during a scan and performs measurements and
analyses on each object found. The data can be displayed in form of histograms where each color-
coded data point represents the results of one object — or of several objects that happen to have identi-
cal results. The results — and thus the objects — can be grouped by Gates and Regions. The Gates
allow classifying the objects according to their properties, i.e. the parameters that were extracted for
these objects. Once these gates are defined, they can be applied to all further measurements for auto-
matic quantification. The gates are administered in the Gate Manager, here you find also access to the
Well Results dialog which contains the detailed results for all wells.

4.2.1 Gates and regions

scan® distinguishes between Gates and Regions. Regions define classification rules in form of poly-
gons or ranges in histograms. Gates are composed of one such region or of several regions that are
linked with Boolean operators (AND, OR, AND NOT). Once a Gate is set, only data points within its
boundary are being considered in further steps.

Gates and Regions can be created using the drawing tool beside each scatter plot. A Region can be
defined as Gate by selecting Set Gate in the histogram context menu or by defining a gate in the Gate
Manager. (See Chapter 2.4, Managing histograms and scatter plots.)

By clicking on the borderline the Region can be displaced. By clicking one corner of the region this cor-
ner can be moved in order to include or exclude data points.

Right-clicking on the borderline of a Region opens the Region context menu. (See Chapter 2.4.3, The
region context menu).

4.2.2 The gate manager

The command Analysis » Assay Gating opens the Gate Manager, which allows converting Regions
into Gates and to combine Regions by Boolean operations. The Gate Manager also gives an overview
of the results in the histograms (H1 to H4) and the applied Gates.

Regions. This lists all regions drawn into the histograms.

Show. Click here to display the selected Region in the histogram selected in the Gate application list.
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= Assay Gating

Regions Edit Gate Gates
RO1 Name Definition
RO2 Name Selected RO1 AND RO2 Ml REsults
RO3 Selected G1 (RO1 AND R02) AND RD3
R04 62 (RO1 AND RO2) AND R04
Definition
RO1 AND R02

Remove

Gate application Applied gate
H1 None 15279 100.0 8.9E+2 4.1E+2 46.3 1.1E+0 1.9E-1 170
H2 Selected 8225 53.8 8.2E+2 24E+2 288 1.7E+3 5.3E+2 319
H3 Selected 8225 53.8 1.3E+6 4.9E+5 0.0E+D 0.0E+0 NaN Gallery
H4 Selected 8225 53.8 1.3E+6 4.9E+5 383 0.0E+D 0.0E+0 NaN

Export Data

Edit Regions

Remove

Remove (Region Box). This command removes the selected entry from the Regions list and deletes the
defined Region.

Gates. It lists all gates with their Names and Definitions.
Name. Set the name of a Gate.

Color. Click into the box to open the dialog window to select the color of the object boundaries when
displayed in the image viewer. This color is also used for color gating. (Compare Chapter 2.4, Managing
histograms and scatter plots.)

Definition. A Region or a Boolean combination (via “AND”, “OR” or “AND NOT") of Regions can be set
to define the Gate.

New. Click here to add a new Gate. The default Name and default Definition will be that of a region in
the Regions list. The Name can be modified at will; the definition must be a region or a logical combina-
tion of regions.

Remove. This command removes the selected entry from the Gates list.

Gate Application. This table lists all histograms with the applied Gates and statistical information about
the gated data. (Number of Objects (Count), Percentage of total number of detected objects (% Tot.),
Mean Value, STDV and CV% for the parameters plotted along the X and Y-axis)

Histogram. Number of the histogram window in the scan® Analysis front panel, H1 to H4, respectively.
Gate Name. Gate applied to the histogram.

Count. Number of objects in the histogram.

%Tot. Amount of objects in percent of the total objects.

xMean (yMean). Mean value of the abscissa (ordinate) parameter of all objects in the histogram.

XCV (yCV). Standard deviation of the abscissa (ordinate) parameter of all objects in the histogram
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xCV% (yCV%). Coefficient of variation of the abscissa (ordinate) parameter of all objects in the histo-
gram

Applied Gate. This command allows changing the applied gate in the selected histogram. The drop-
down list lists all gates from the Gates table.

Gallery. This command generates an image gallery of all objects in the selected histogram. The number
of images is by default limited to 100. If the histogram contains more objects the 100 objects closest to
the center of gravity of the region will be shown by default. (See Chapter 2.2, Preferences.)

Export Data: This command exports the data of the selected histogram as tabulator delimited table in txt
format.

Edit Regions: You can select the region that you want to change numerically from the Region drop-
down list.

Well Results. This opens the Well Results window, see Chapter 4.4, Well results.

4.2.3 Color gating

Color Gating shows different populations as defined by the gates in different colors in the one- and two-
dimensional histograms. Color Gating is a property of each individual histogram displayed; thus, histo-
grams with and without Color Gating can be displayed simultaneously in the different displays.

In order to activate Color Gating right-click in the histogram and from the context menu (right click)
activate the option Settings » Color Gating. The Settings » Show Legend option activates the legend
of the colors in the histogram. The population percentages of the displayed gates are also displayed.

Clone From

Gallery

Zoom out

Settings Autoscale XY
Autoscale Z

/ Color gating
J Show Legend

Theme

Advanced...

The following rules apply to decide which color is shown in Color Gating:
- If there is only one object located on a pixel (Bin) the gating color of that object is shown.
- If there are multiple objects on a histogram pixel the gating color of the relative majority of the

objects will be shown. Exception: If there is a gate applied to the histogram, that gate will be au-

tomatically in the background as 100% of the objects will belong to that Gate.
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Objects not belonging to a gate are shown in black.

If there is no majority, the Gate Color order of the Gating list will be used (Analysis » Assay
Gating...; see Chapter 4.2.2, The gate manager). The "ranking" can be changed with the arrow

buttons in that window.

If a histogram is gated (context menu: Set Gate) the objects will be shown in the color of the
sub-gate they belong to.

1000.0 Cells

950.0 W Types 330
q00.0 Typeb 1032
8a0.0 Typel 22.30
B800.0 M TypeD 0852
7500 TypeE 150
F00.0 W TypeF 356

B50.0 M TypeG 270
B00.0 e

5a0.0
500.0
450.0
400.0
360.0
300.0
2h0.0
200.0
150.0
100.0

50.0

Counts

M TypeH 211
Cells 100.00

0.0 :

01 1.0 10,0 1000 1000.0
Color

The order mechanism of Color Display (1-D):

In 1-D histograms the applied Gate is always in the background.

The order of display is organized by areas. If one of the Gates has less area above the other

one it will be shown in the foreground.

If Auto Z Order is disabled in the histogram settings (see Chapter 2.4.2, The histogram prop-
erties dialog), the Gate Color order of the Gating list will be used (Analysis » Assay Gating...;
see Chapter 4.2.2, The gate manager). The "ranking" can be changed with the arrow buttons in

that window.

@ area you will get an object from the green Gate, if you click on gray you will get one from the

The selector line is position-sensitive in 1-D Histograms as well. Thus if you click on a green

gray Gate.

Examples:

1. The example below shows a cell cycle with G1 and G2 defined as gates with different colors.
The histogram is not gated, thus all detected objects are shown. Some of the pixels represent
more than one object. In this case all pixels that have at least one object that belongs to the
gate Selected are shown in red. Only the red color is shown because there is never a majority
of G1 or G2 because G1 and G2 are subgroups of Selected and the order in the Gate Man-
ager is Selected above G1 and G2. The other objects are shown in Black because they do
not belong to any Gate.
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Selected

400.0 600, 0 1.0 1400.0

#an Accay Gating

Regions Edit Gate Gates
RO1 MName Definition
RO2 Selected RO1 AND ROZ
RO3 Selected G1 (RO1 AND ROZ) AND R03
RO4 G2 (R01 AND R02) AND RO4
Definition
RO1 AND

2. In this example the situation is identical to the first example, but the order has been changed.
All Pixels having a majority of G1 will now be shown in a green. All G1 objects also belong to
Selected but when the same number of objects belongs to G1 and to Selected the color of the
data point is determined by the list order and now G1 has a higher priority than Selected.

Selected

#50.0 1000.0 01500.01 X 49 400.0 6000 0 10000 .0 14000 1600.0 l"’l

= Accay Gating

Regions Edit Gate
RO1 Definition
ROZ MName (RO1 AND RD2) AND RO3
RO3 RO1 AND ROZ
RO4 (RO1 AND R02) AND RO4
Definition
(RO1 AND R02) AND
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3. In the last example the order is changed again, but now also the gate Selected is applied to
the histogram. Now the exception Rule 2) applies such that the Selected is not dominant.

Selected

= Assay Gating

Regions
RO1
RO2
RO3
RO4

4.3 Adjustment and alignment of regions

Edit Gate

Mame

Definition
(RO1 AND ROZ)} AND RD4

Definition

(RO1 AND R0O2) AND RO3
(RO AND R02) AND RO4
RO1 AND ROZ2

The regions in one histogram can be numerically adjusted and if multiple regions are created in one

histogram, these regions can be aligned with respect to each other.

First draw a region in the first histogram by selecting the polygon tool. Close the region with a double-
click. To numerically adjust the created polygon, go to Analysis » Assay Gating and highlight in the
Gate application list the histogram in which you have created the region. Then click on Edit Regions.
The Edit Regions dialog opens.
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ﬁ Edit Regions
Remove Node
Region
RO1 w
X Y - .
Align to
622,704 1.20527 -
397.443 117055
244,266 1.15799
226.245 114174
280.308 1.02208
1352.55 1.02208
1145.31 112032 Rescale
739.84 1.20748
10
1-I
0.1
v 1 5
Cancel QK

Edit Regions dialog

In the Region drop-down list you can select the region that you want to change numerically. The list will
then show the x and y positions of the nodes of this region. You can change these values by entering
numbers in the list. When you click on one of these values the Remove Node button will become ac-
cessible. With this button, single nodes of the polygon can be removed. Similarly, a new node can be
created by entering the x and y values in a new line of the list.

With the Rescale slider or the corresponding numerical box below the slider, you can scale the polygon
you have created. Values greater than 1 will increase the size of the polygon, values smaller than one
will decrease the size of the polygon. The x and y values in the list will be adapted accordingly.

In the case that more than one region is created in one histogram, these Regions will become available
in the Region drop-down list and the Align to button will become active. For example, the following
regions are created.
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Now region R02 and region R03 will be aligned. In the Edit regions window Select R03 in the Region
drop-down list and select Align to R02. Click on Align to. This will update the x, y coordinates of the
Region R03. Click OK to leave the dialog. The Regions R02 and R03 will now be aligned.

Aligning regions means that two regions will have one common, identical border. Since re-
gions are handled as intervals excluding their end points, objects positioned exactly at the
common regions’ border might be contained in neither region.

4.4 Well results

The Well Results window shows the results of a complete scan analysis. It can be accessed from the
Assay Gating window (Analysis » Assay Gating » Well Results), from the Plate window
(Scan » Plate » Well Results), or using the main menu (View » Well Results). Statistical results of
different parameters are listed for gated populations of the individual wells or of groups of wells and are
displayed graphically in a histogram. Additionally, the results can be exported as txt-file for further analy-
sis with other software.

4.4.1 Measurement results

The Measurement Results tab lists all the wells recorded in one measurement and displays the results
(Number of Objects, Tot. %., Mean, Error, Error % and CV) of the measurement parameter which is
selected in the drop-down list Measurement. The result for a combination of several wells is given in the
bottom line when several wells are selected (press shift and click the lines you want to combine).The
results can be exported by Export Table. The graph on the right gives a graphical representation of the
results.

Well/Group results. This table gives a statistical analysis of the measurement results for each well or
group of wells. It lists the mean value of a parameter for the gated population in each well or group of
wells as well as its error and coefficient of variation.

Objects. Number of objects belonging to the population of the selected Gate

Tot %. Relative size of the Gated population

Mean. Mean value of the selected Parameter. It is shown in red in the histogram.
Error. Absolute error of Mean. It is shown in green in the bar plot.

Error %. Relative error

CV%. Coefficient of variation of Mean.

StdV. Standard deviation of Mean. It is shown in blue in the bar plot.
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=4 Well Results
Measurement Results  populations ~ Export Definitions

Well/Group results Object type

[Group [Name/Description |Objects | Tot.% |Mean  |Eror | Emor% [CV% | Main
B1 573 56.7 1.205E+6 1.99E+4 154 36.86

B2 54.0 1.240E+6 1.78E+4 144 36.

[:] 3 56.6 1.261E+6 1.71E+4 136 3

B4 3 E: 1.330E+6 1.95E+4 147 39.51 Measurement

B3 1461E+6 1.83E+4 125 35.73 Total Intensity DAPI

B 1434E+6 1.97E+4 137 i

B7 E 1.418E+6 1.76E+4 124 36.06

4 1.400E+6& 1.92E+4 137 36.88

a 5 1.274E+6 2A43E+4 1.80 4255 =

c2 i 1.246E+6 1.96E+4 157 4042 1.6E+6 M

c3 L 1.184E+6 1.72E+4 145 39.31

c4 . 1.368E+6 1.96E+4 144 38.29 1.4E+6

Cc5 8 #: 1.410E+6 2.04E+4 145 EYN /A

c6 : : 1.203E+6 1.78E+4 138 38.1¢ 1.2E+6

lor} 8 . 1.364E+6 1.82E+4 134

c8 g X 1.204E+6 1.68E+4 130

=
i Selected

Well/Group results

w6 N s ow o =

==
=3

1E+6

BE+5

6E+5

Total Intensity DAPI

4E+5
2E+5

0E+0
10 25 5.0 75 100 125
Group

5 ined: | 5019
Selected combined: | 5019 Export Table

Groups Cancel

Object Type. Select the object type from the drop-down list (Main/Sub-objects).

Gate. Select a gate from the drop-down list in order to get the values for the corresponding gated popu-
lation.

Measurement. Select the parameter of interest from the drop-down list.

Selected combined. Select a number of Well/Group entries (press shift and click in the lines you want
to combine), their combined results will be given here.

Export Table. This function exports the data as tabulator delimited table in txt format.

Wells / Groups. Use this button to select if the values are to be given for individual wells or entire
groups of wells. All wells that have the same Name / Description entry form a group. Wells that do not
pertain to a group will be listed independently. The Name / Description is set in Scan » Plate (see
Chapter 2.7, Selecting Wells for Analysis).

4.4.2  Population results

In the Populations tab the number of objects (absolute and relative) in all defined gates are listed. A
reference gate can be set to relate the number of objects in all other gates to the reference gate. The
histogram on the right gives a graphical representation of the results.

Well/Group Results. The table gives the amount of objects in absolute numbers or as percentages that
pertain to each of the Gates defined in the Gates Manager. (See Chapter 4.2.2, The gate manager.)
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Display Counts / %. This toggle button switches between the listing of total numbers and the percent-
age of objects.

Object type. Select the object type from the pull-down list (Main/Sub-objects).

Reference gate. The population of the selected Reference gate is set relative to the populations of the
other gates in the Size comparison table.

Export Table. This function exports the data as tabulator delimited table in txt format.

Wells / Groups. Use this button to select if the values are to be given for individual wells or entire
groups of wells. All wells that have the same Name / Description entry form a group. Wells that do not
pertain to a group will be listed independently. The Name / Description is set during acquisition already
or after acquisition in Scan » Plate. (See Chapter 2.7 Interactive plate result view.)

=+ Well Results

Measurement Results ~ Populations  Export Definitions

Counts
Well/Group results Display Object type
[ar—— [e1  [62  [Selected | | Main
10m 296 163 573
Reference gate
B2 1205 343 154 651 Al
B3 1365 E) 180 T3
B4 39 3 217 723
B5 £ 3 282 814
B6 339 266 752

87 287 842
83 3 3 223 720 S ]

2 145 660

4 E 214 m

s : 238 678

c6 206 768 8E+2
ord m 788 TE+2
8 99 239

Fl 0 0

F2 0 0 5E+2

Gated populations

9E+2

6E+2

3 0 0 2 4E.7
4 0 0
5 0 0
F6 0 0 2E+2
£ 0 0 1E+2
= 0 0

3E+2

0E+0
100 150 200
Group
Export Table

Groups

443 Export definitions

In the Export Definitions tab the parameters that are to be exported can be defined. This is especially
useful for batch analysis and if not the complete results tables given in the Populations or the Meas-
urements tab is to be exported.

Select New to create a new export file. The parameters to be exported have to be selected in the other
tabs, i.e. in the Populations tab or in the Measurement Results tab. When you right-click in these two
tabs on the column names a context menu will open which allows you to export the selected column to a
tab-delimited .txt-file.
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Measurement Results ~ Populations  Export Definitions

) Counts
Well/Group results Display
Group | Mame / Description All G1 * Add to Absolute.tt
81 0L 296 | Add to Relative.bit
2 242
1205 31 Add to AlResults.bxt

3 2
L S Add to new File ...
1396 341 —

1448 320 282
1339 316

= @ n P

= Well Results

Measurement Results ~ Populations  Export Definitions

Export file name
AllResults.bd

Remove

File Name Wells / Groups [
Absolute.brd Groups All All All
#in #in #in
G1 G2 Selected
Relative. bt Groups All All All
% in % in % in
G1 G2 Selected
AllResults. bt Groups All All All
% in % in % in
All G1 G2

Groups Cancel

Once the export files are defined, there are three different workflows for exporting the result data:

- Manual export. Press the Export button to select manually a folder to export the current results.

- Automatic export to scan folder. If no common Results Export Directory is defined in the
Preferences, the result files will be written to a new subfolder “Population Results” at the same
location where the scan is stored. This happens automatically whenever the analysis results are
saved by Analysis » Save or Analysis » Save as...

- Automatic export to common results folder. If a common Results Export Directory is defined,
the result files will be stored there whenever the analysis results are saved. The name of the
analysis (*.sca) file will be added to the export file names in order to document the origin of the
exported results.

New. Creates a new tab-delimited .txt-file for export.

Export file name. Enter the name for the txt file here. The default is ResultO*.txt
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Remove. Removes the selected File and its selection

Export. Allows setting set the folder where the .txt-files are stored manually. Otherwise the folder given
in the Preferences is used.

Wells / Groups. Use this button to select if the values are to be given for individual wells or entire
groups of wells. All wells that have the same Name / Description entry form a group. Wells that do not
pertain to a group will be listed independently. The Name / Description is set in Scan » Plate. (See
Chapter 2.7 Interactive plate result view.)

444  Export results of individual objects

Analysis » Export Table: exports the parameter values determined for each detected object to a spread
sheet. The values exported depend on the active view (Population view or Trace view). When also sub-
objects are detected, not only one file is exported but for each sub-object a separate list is exported. For
the “Population view” the list contains for example:

ParameterData_Main.txt
ObjectlD MeanlintensityDAPI Subobject 1Counts ParentObject|D ParentTracelD RO1

0 174,52045 NaN -1 0 0
1 295,50986 2 -1 1 1
2 220,76321 1 -1 2 1
3 161,89612 NaN -1 3 0
ParameterData_Subobject 1.txt

ObjectID Total Intensity GM130 Area Parent Object ID  ParentTracelD RO1
0 201294 608 1 1 0
1 2504 12 1 1 0
2 2232 12 2 2 0
3 41191 108 4 4 0
4 4860 18 4 4 0

Object ID. ID of the detected object

e Parameters. (e.g., MeanIntensityDAPI, Area,....)

e Derived Parameters.

e Parent Object ID. -1 if it is the main object; if not, the ID of the main object is given

e ParentTracelD. if tracking was performed the ID of the Trace the detected object belongs to is
given. If no tracking was performed the Trace ID is set to -1.

e Gates. If the object belongs to the listed gate the value is set to 1, if not it is set to 0.

For the “Trace view” the list contains:

TracelD lifetime max(Area) TrackedObjType  TracelLength FirstParticlelD LastParticlelD RO1
0 1 31 0 1 0 0 0
1 15 78 0 15 1 1940 0
2 8 626 0 8 2 1041 0
3 19 849 0 19 3 2640 0

e Trace ID. The ID of the Trace

e Parameters of the Trace (e.qg. lifetime, max(Area),...)
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e Derived Parameters.

e Traced Obj. Type. (O=main object; 1, 2, 3,.... Sub-object type)

e Trace Length. Number of objects in subsequent time frames belonging to the Trace
e First Particle ID. ID of the first object belonging to the Trace

e Last Particle ID. ID of the last object belonging to the Trace

e Gates. If the object belongs to the listed gate ate the value is set to 1, if not it is set to O.
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5 Example Assay — Step by Step

This chapter guides you step by step through the setup and execution of an assay and the analysis of
the results.
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5.1 Setting up and executing an assay

The example scan which is used here to guide you through the setup and execution of an assay con-
sists of images taken from cells labeled with DAPI to mark the nuclei and with FITC to mark the microtu-
bules. A repair protein which is active in late G2 phase stained with TexasRed.

1.

Execute Scan » Open..., navigate to the folder where the demo data are stored, select the
experiment_descriptor.xml  file  (scanR_Demo_Data_DVD/Slabicki_Buchholz_MPI-CBG/
H2AX_PFA_002/experiment_descriptor.xml; sample data kindly provided by F. Buchholz,
MPI-CBC, Dresden) and open it with OK.

scan® Analysis loads the first image of the scan, i.e., the image acquired at the first position
of the first well is displayed in the main window of the font panel. Only the first channel of the
image will be shown at first and in gray scale. Move the cursor over the image as a test and
observe the status bar at the lower left. The channel intensity of each channel at the pixel po-
sitioned at the tip of the cursor arrow is shown in the status bar. The intensity values of the
objects are usually much higher than the camera offset; the dark intensity of the camera.
Memorize the intensity values of the brighter structures in the image for the subsequent dis-
play adjustment.

Set the grayscale selector to None, and load the dapi channel in the blue selector and the
TxRed channel in the red selector.

Display

Execute View » Adjust Display and adjust the display settings as explained in Chapter 2.5,
Using the Image Viewer.

The first step in setting-up the assay is to find the best settings for the object detection. If you
would have opened an old analysis file (*.sca), rather than the scan data only, the histograms
would already show the data points of the analysis that was run before. In order to get these
results from-scratch you first have to set up a new assay to perform a background correction,
determine main (and sub-) objects, and the parameters you want to extract from the data.
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5. Execute Analysis » Assay Settings... to open the Assay Settings window.
The first step is to select the Background Correction Image processor Module on the Image
Processing tab for each of the image channels. Press Adjust and observe in the new win-
dow the background in the image before (left) and after (right) background correction. When
moving the mouse over the pixels the grey value should be reduced in the corrected images.

i Assay Settings

Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Image processors Image processor
Module Channel ~ 4
BackgroundCorrection dapi Medule
BackgroundCorrection TxRed + BackgroundCorrection =
Color channel
dapi ~
Adjust
MNew Remove

7. The next step is to determine the main objects. Therefore go to the Main Object tab in the
Assay Settings. Here you have to select the channel in which you want to use for image
segmentation. In many typical cases this will be the channel with the DAPI-labeled nuclei, the
shape of which makes them rather ideal targets for object detection.

= Assay Settings

Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Main-ohject finder Module settings
~
Name [ Settings
Main
Color Channel
dapi
J dapi
bright
TxRed
Settings ist
Default v
Adjust

8. For image segmentation use the Intensity module. Both the Edge and the Intensity modules
usually give good results when detecting nuclei. In other cases this is mostly a question of ex-
perience and testing. Click Adjust to open the Object Finder window. Here you can check
and adjust the settings of the intensity detection algorithm. You will already get a good result
by simply pressing the Auto button for determining the right threshold value and turn the Wa-
tershed algorithm ON. You can observe the effects of the parameters in the right panel where
the result of the segmentation algorithm is shown.

89
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=% Object Finder: Intensity Threshold

13441024 1 Signed 16-bit image & (234,270) Intensity clipping 0 2| |1344x1024 1X Signed 16-bit image 0 (637,483)
Settings Objects found Images
944 A2—WDO0G2--PODDOT--Z0000D--T0000D- -

A2 \WODOO2:-PD0DN2-- Z00000--T00000-- dapi if
A2--\WDDOO2--PODO3-- Z00000--T00000--dapi Hf

Threshold Auto 503 A2--W00002- -POD004--Z00000--T00000- - dapi.tif
A2--\WDDOO2--P DS Z00000--T00000--dapi Hf

Watershed A2--WW00002--P D000~ Z00D00--T00000--dapi.tif
A3 \WODOO3: -P 0D Z00000--T00000--dapi Hf

A3--\W00003--PODDD2-~Z00000--T00000-- dapi 1f

[ D A3 \WDDOO3: -P 0O Z00000--T00000--dap Hf
A3--\W00003--P0DDD-~Z00000--T00000--dapi 1f
[AFill holes within objects A3--WD0OD3- -POODDS-~Z00DDO--T0DDOD-- dapi £
EAMinimunn object size 00 1 pinels) A3--\W0003--P O0DDE-~Z00000--T00000--dapi 1f

[AMaximum object size 1000000 ] (pixels)

Cancel oK

DAPI-labeled nuclei (Detected objects)

If Sub-objects are associated with the Main Objects, check and adjust their detection in the
same way on the corresponding tab in the Assay Settings window. In this example skip the
Sub-objects tab.

10.

In the Parameter tab you can choose which parameters will be calculated during the analysis,
i.e. you need to select the measurements that are to be carried out. Typical measurements
are area, mean intensity and total intensity, and the circularity factor. Area (size) and circulari-
ty factor are extremely helpful as they allow to discriminate between more or less round, sin-
gle nuclei and impurities or objects that consist of clustered, non-separable nuclei. The latter
are usually much larger and less circular. If sub-objects are to be detected it is useful to add
the parameter Subobject. 1 Counts to the list to determine how many sub-objects are con-
nected to each main object. For this example, simply press the Auto button to add the most
relevant parameters automatically to the list.
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=n Assay Settings

Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Parameters Measurement
| 1o} ‘ Measurement | Channel | Object ~ Area ~
pl | Area Main
Color Channel
p3 | Total Intensity dapi Main dapi
p4 | Mean Intensity dapi Main
p3 | Total Intensity TxRed Main
Object
pE | Mean Intensity TxRed Main
Main ~
New Remove

Auto

Compatibility Status
D Fix CCs - Cancel oK

11.

The Derived Parameters tab allows you to perform calculations on the previously defined pa-
rameters, e.g. here you can calculate ratios between different color channels. (For example
you could evaluate the ratio “mean Intensity Dapi / mean Intensity TxRed").

12.

Now you have set up the analysis. Press OK to exit the Assay Settings dialog. You can save
your assay with Analysis » Save Assay...

13.

Start the analysis by clicking on the Run button.

14.

Prepare the histograms in the main window if you want to follow the analysis online. It is suit-
able to select the parameters Area and Circularity Factor in the first histogram and to dis-
play Total intensity dapi vs. Mean intensity TxRed in the second histogram. The small
image window next to the main window shows the main object recognition in the image that is
currently being analyzed. By clicking on the Main Display button you can display the current
image in the large image window.

; D Main Display

Analyser
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5.2 Analyzing the data

1.

The first thing to do is to get an overview of the detected main objects, in our example the cell
nuclei. The nuclei should all have a similar size and a more or less round shape, i.e. a Circu-
larity Factor (CF) close to 1.0.

Set Area as X-axis parameter and Circularity Factor as Y-axis parameter and examine the
size/shape distribution of object population in the scatter plots. The bulk of the population of
the example has a CF of <1.1 and an area of around 300..400 pixels in images taken with 4x
magnification.

Clustered cells

CF=12
Area = 1130 pixels

1500.0

Area

Area w 1.13E+3

Circularity Factor w 1.20E+0

Objects that are larger and have a larger Circularity Factor may for example consist of clus-
tered cells that could not be separated by the watershed algorithm.

For further analysis only consider those objects that do not differ significantly in size and
shape from the bulk. To do so, use the Region tool and draw a polygon around the
most densely populated part of the scatter plot. (Close the region by double clicking).
Right-click on the contour of RO1 in the scatter plot to open the context menu and select Gate.
By doing so, the region RO1 is converted in a gate of the same name (R01) and you can apply
this gate to all other histograms to exclude all objects outside this gate. Right-click again and
select Set Gate » none to get back all objects.

Right-click on the border of the polygon and select Gallery to display a selection of objects in-
side the gate; this allows you to roughly evaluate if your gating was set in a useful way.

In the next histogram display the Total Intensity dapi vs. the Mean Intensity TxRed. To in-
clude only the objects in RO1 right-click in the histogram and select Set Gate » RO1. You will
observe a cluster around the total Intensity dapi of ~9x10° and another cluster around
1.8x108. The left cluster consists of the nuclei in G1, whereas the cluster with twice the dapi
intensity contains the nuclei in G2. (With G2 cells having twice the amount of DNA they will
have twice the amount of DAPI-labeling and thus roughly twice the fluorescence intensity.)
Draw a polygon around the cluster on the left with the Region tool and keep in mind the name
(R0O2). Execute Analysis » Assay Gating to open the Gate Manager window.
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™ Assay Gating

Regions Edit Gate Gates
RO1 [Name  [Defimtion
RO2 Name 61 {RO1) AND ROZ ‘Well Results

RO3 g Nucs RO1
R04
RO3 2 =

Definition

(ROT) AND RO2

Remaove

Click new to create a new gate. You can give the new gate a meaningful name (e.g. G1) and
also select a color. In the Definition line enter RO1 AND R02 to select only the objects which
are contained in both regions. Rename the Gate RO1 to Nuclei; these are the objects defined
in step 2. Then Close the Gate Manager.

4. Next draw a region around the right cloud, i.e. the nuclei in G2 and repeat the steps described
in step 3 and name this gate G2.

5. In the two remaining histograms choose Mean Intensity TxRed for the X and Y axis. This will
give the distribution of objects with a certain amount of TexasRed staining in all nuclei. To find
out if the distribution of TexasRed is different in the G1 and G2 phase right-click and select
Set Gate » G1 in the context menu in one histogram and Set Gate » G2 in the other histo-
gram.
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Object
Main

W-IJ 1}

Object
Main

X

i Y

X

B Y

Mean Intensity TxRed  -w 2.36E+3

Mean Intensity TxRed ~ w 2.36E+3

Mean Intensity TxRed  -w 2.36E+3

Mean Intensity TxRed  w 2.36E+3

6. You will observe that the distributions in G1 and G2 look different. In G1 there are only nuclei
with a low mean intensity in TexasRed, whereas in G2 there are two populations: one with a
lower mean intensity in TexasRed and one with a higher intensity in TexasRed. Again select
the polygon tool to define a region around the two populations in G2 and create two gates ac-
cording to step 3. We name the nuclei with a high concentration of Texas Red G2_active, and
the nuclei with a low concentration G2_passive. The result in the Gate Manager may look as

follows:

=™ Assay Gating

Regions
RO1
RO4
RO5
RO2
RO3

Edit Gate

MName

G2_passive

Definition

RO1 AND RO3 AND RO4

Remove

Gates

Name Definition

Nucs

G1

G2
G2_passive

G2_active

RO1

RO1 AND ROZ

RO1 AND RO3

RO1 AND R03 AND R04
RO1 AND R03 AND R03

Well Results

7. Leave again the Gate Manager window. By right-clicking on the main window you can high-
light the nuclei in the different gates with boxes when you activate them (e.g. Show
Gates » G2_active). Another option to compare the results is to right-click on the border of
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the gate and to choose Region Gallery. Plot a region gallery of G2-Active and G2-passive to
compare the results of the gating.

a0 1 ©

Gallery of G2-passive nuclei Gallery of G2-active nuclei

8. In the lower part of the Gate Manager you will also find statistics of the displayed histograms.
For more detailed results click Well Results in the gate manager and open the tab Popula-
tions. Here you will find the results for all wells and all gates. You can view the display the to-
tal counts or the results as percentages. You can export these results for further analysis. A
graphical display allows you to directly compare the results for different wells. Select G2 as
reference gate and G2, G2_active and G2_passive as gated populations. You will notice that
the fraction of active nuclei in G2 phase is very high in the central 4 wells while it is significant-
ly lower in the other wells.

= Well Results

Measurement Results ~ Populations  Export Definitions

) Counts
Well/Group results Display Object type

Group | Name / Description Nucs Nucs Nucs Nucs Nucs Main
in in in in in in
Al Mucs G2 61 G2_Passive | G2 Actn|  Reference gate
00 0.0 0.0 0.0
A2

0.0 0.0 Nues

1000 1000 377 60.2 18.4 189
A3 1000 100.0 56.9 8.9 219
:%] 1000 1000 66.4 i 16.6 Gated populations
B3 1000 1000 64.6 i 16.9
c2 100.0 100.0 749 . 13.0 G2 -
a 1000 1000 : ! T
D2 1000 1000 L } !
D3 100.0 100.0 9. 3.
E2 100.0 100.0
B 100.0 100.0
F2 100.0 100.0
] 1000 1000

1.0 20 40 6.0 a0 100  12.013.0
Group
Export Table

Groups
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5.3

9. To export the results either select Export Table in the Populations or Measurement Results

or select the results to be exported via Export Definitions as described in Chapter 4.4.3, Ex-
port definitions

Time-lapse analysis

In this example a time-lapse series is analyzed. The images of the example show cells during mitosis.
The cells are marked with two stains (GFP and TxRed). The images left and right show images from the
same well and position, taken at two different time points (=10, t=50). In order to analyze time-lapse
data it is necessary to segment the images properly and to track the moving cells from frame to frame.

Execute Scan » Open..., navigate to the folder where the demo data are stored, select the
experiment_descriptor.xml file ( scanR_Demo_Data_DVD/Slabicki_Buch-holz_MPI-
CBG/CMV-mRed+cyclineB1GFP/GFP+mRed_001/experiment_descriptor.xml; sample data
kindly provided by F. Buchholz, MPI-CBC, Dresden) and open it with OK.

Execute Analysis » Assay Settings to open the Assay Settings window.

Go to the Image processor module in the Image Processing tab to set Background Cor-
rection for all channels (TxRed and GFP). Press Adjust and observe in the new window the
background in the image before (left) and after (right) background correction. When moving
the mouse over the pixels the grey value should be reduced in the corrected images.

Open the Main Object tab in the Assay Settings. Here you have to select the channel which
you want to use for image segmentation. Select the TxRed channel (which has the stronger
signal) for image segmentation and use the intensity module. Click on Adjust: The Object
Finder: Intensity Threshold dialog opens. Press Auto to set the threshold and use the wa-
tershed algorithm.
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B Otsect Finder Intensity Threshetd

Irtensity cipping

Settings Qbjects found

Theeshold aute
Waterched ON

[ignore bordes objects

Il holes within cbjects

=

mum ebject size W0 ek

[ Maumum oiject size 10000 5 (pieeds)

Cancel oK

5. Skip the sub-object tab.

6. Go to the Parameters tab. Select here the parameters you want to detect for the main object.
Select Area and Circularity Factor, which are determined on the channel of the main object
(i.e. TxRed). For the GFP Channel select Mean Intensity and Total Intensity. Note that the
intensities of the GFP channel are also detected on the main object (which was originally
segmented using the TxRed channel).
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& Assay Settings X
Main Object Sub-objects Parameters Derived Parameters Image Processing Virtual Channels Image Export
Parameters Measurement
ID | Measurement Channel Object ~ Area ~
p2 | Circularity Factor Main Color Channel
p3 | Time Main GFP
p4 | Total Intensity GFP Main
p3 | Mean Intensity GFP Main
Object
pb | Total Intensity TxRed Main
p7 | Mean Intensity TxRed Main Main >
New Remove
Auto
v
Compatibility Status
D Fix CCs - Cancel oK

7. Confirm the Assay Settings with OK and Run the analysis.

8. During and after the analysis you can plot the histograms and scatter plots as described in
Chapter 5.2, Analyzing the data.

9. The next step after the image segmentation and the extraction of the parameters is the track-
ing of the objects. Go to Kinetic » Configure Tracer. Check the Enable Tracking box and
select Main as tracked object. Set a range of 20 pixels. Confirm with OK. When leaving this
dialog the tracking will start. The progress of the tracking is shown in the status bar.

DMain Display

Tracer

10. After the tracking is finished, the Define Parameters dialog is enabled. Here you can browse
through the traces and determine the kinetic parameters that will be extracted from the
curves. Select those operators which will be applied to the kinetic curves of the selected Pa-
rameters. In this example we want to find all the cells that undergo mitosis during the meas-
urement. During the process of mitosis, the cells show an increase in the mean intensity of
GFP. First set the smoothing to ~1 to obtain smoothed curves. In order to find out the mitotic
cells in a simple approach set the following definitions: We need the
max(MeanIntensity(GFP)) to find out the maximum intensity of the curve. Then we need the
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lifetime to gate on the cells that are tracked over all images. We are also interested in the
time point when the maximum mean intensity is reached. Therefore select also
t_max(MeanIntensity (GFP))

Original Parameters Derived Parameters

269.043
250-

Well
15 w

235'; Position
200~ 1 ~ .
1?5’2 Trace ¥

E 1500 BB
=3 B
& 125
g o0
= - Add Range
H 75<
2 -
2 sl Add Threshold
W8165, :
D 10 2 30 4 0 s 70 8 9 100 10 120 130 140 femove
Absolute time
Derivative
Parameter Mean Intensity (GFP) ~
Smoocthing (sigma) '
0.01 01 1 13
Definitions Mame
Name Operator Result ~ t_max{Meanlintensity(GFP))
max(Meanlntensity{GFP)) max 257.9
lifetime lifetime | 141 Operator
Advanced
v New Remove
Cormpatibility Status |
oK ) Cancel oK |

11. Close the dialog with OK. The analysis of the curves is performed. In the lower right of the
front panel the status bar displays the progress of the analysis.

12. Switch to Trace View. When the analysis is finished you can plot a lifetime histogram in the
first histogram panel. In order to select the cells that were detected in all timeframes draw a

rectangle around the data points at 140. Right-click on the region border and select Gate to
convert the region into a gate.
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13. Go to Analysis » Assay Gating... and rename the Gate RO1 to longtraces. Leave the dia-

log with OK.

s Assay Gating

Regions Edit Gate Gates
RO1 [Name  [Defintion
RO2 Name Color Long Traces RO1 Well Results
RO3
RO4
RO5

Long Traces

Definition

Remove

14. In the second histogram display, plot max(MeanIntensity(GFP)). Right-click in the histogram

and select Set Gate » Longtraces in order to include only the cells that were detected in all
images into the analysis. Draw a rectangle around the datapoints on the right. These are the
cells which show a high mean intensity of GFP. Right-click on the border of the rectangle and
select Gate. The new gate longtraces AND RO2 is created.

15.

Select one of the data points and the corresponding cell is shown in the image display with a
green outline. Right-click on the image of the cell and select show trace from the context
menu. The Trace Viewer opens and displays the curve of the selected cell. In order to show
all the traces of the gated cells, deactivate single mode and for Gate select longtraces AND
R0O2. The curves show all the same characteristics.
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ﬁ Trace View

277140.0-
260000.0-

240000.0-
220000.0-
200000.0-
180000.0-

ity

160000.0-
140000.0-

Total Intensi

120000.0-

1 1 1 1 1 1 1
0 10 20 30 40 50 & 70 80 90
Absolute time
Absolute time

Total Intensity (GFP)

Time scale
Parameter

Smoothing '

Gigma) o 51 0.1 1

1 1 1 | 1
100 110 120 130 140

L

Derivative

O

Gate
long traces AND|

Mazx. displ. traces

1000

1

Single mode

O

10 15

16. As default the Time scale is set to Absolute time but it is also possible to display and ana-

lyze the curves regarding to a certain timepoint, e.g. the time of mitosis. Therefore select

t_max(MeanlIntensity(GFP)) as Time scale.

ﬁ Trace View
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17.

As you can see, there is one (blue) curve which shows no mitosis but has a high mean inten-
sity in GFP all the time. (When you select the blue curve and observe the corresponding ob-
ject in the images you see that this is probably an apoptotic cell). In order to improve the
classification, you can set up a more advanced analysis, e.g. you can set the parameters
max(MeanIntensity(GFP)) and min(MeanIntensity(GFP)) in the Trace Parameters dialog
(therefore go back again to Kinetic » Define Parameters). Go to the Derived Parameters
tab In the Trace Parameters dialog and set as new derived parameter the ratio of
max(MeanlIntensity(GFP)) and min(Meanintensity (GFP)). Name this new parameter ratio.

B Define Kinetic Parameters X
Original Parameters Derived Parameters
Original Parameters
Id Mame A
pl lifetime
p2 t_max(Meanintensity{GFP])
p3 min({Meanlntensity(GFP))
v
Derived Parameters MNarmne
Id Mame Formula ~ ratio
Formula
p0/03
Remove New
v
Compatibility Status
D oK > Cancel oK

18.

After running the trace analysis plot a histogram of ratio. Set again longtraces as gate. The
data points around 1 show about the same minimum and maximum mean intensity of GFP.
Whereas data points >1 are the ones that undergo mitosis and have a higher maximum mean
intensity. Draw a rectangle around the data points with ratio >1. Right-click on the border of
the rectangle and select Gate. The new gate longtraces AND RO03 is created.

19.

Mark one of the data points and the corresponding cell is shown in the image display with a
green outline. Right-click on the image of the cell and select show trace. In order to show all
the traces of the gated cells, deactivate single mode and as gate select longtraces AND
R03. You will see that this parameters lead to a better discrimination of mitotic cells than the
more simple approach used before.
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ﬁ Trace View
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6 scan® Al

This chapter introduces the concepts of self-learning microscopy. It shows how to train a deep learning
Al model which can be used for advanced image analysis tasks, and how to apply trained models for
image analysis and object classification.
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6.1 The general concept of self-learning microscopy

In self-learning microscopy, a neural network is trained without the need for manual annotations to de-
tect particular features within images. In order to train the network, the features to be detected later by
the network are once detected by other means, for example, by acquiring more image data only for the
training. The extra data acquired only for the training is analyzed with conventional means, and features
are detected. These detected features, or, more precisely, the segmentation masks, are used as
“ground truth” to teach the neural network how to detect the same features in the actual data. Since the
whole scan® workflow is optimized for this kind of automatic data acquisition and analysis, the training
phase can be executed almost without any work for the operator. Typically, large amounts of data are
acquired automatically and used for training. This data amount makes it possible to train a neural net-
work to achieve excellent detection performance and robustness even in the most challenging situa-
tions.

For example, it is easy to train a neural network to detect nuclei in extremely low-light conditions. This
capability has important applications because it dramatically reduces the amount of light exposure to the
sample without trade-offs in analysis potentials and accuracy. To train a neural network for nuclei detec-
tion in noisy image conditions, the scan® Acquisition is set up to acquire pairs of well-exposed images
and weakly exposed images of a larger part of a sample, for example, a whole well plate. This scan is
analyzed by scan® Analysis using the well-exposed channel for object detection. The entire image ac-
quisition and object detection process takes only little time and can be performed easily using the stand-
ard scan® workflow. The data then is fed into neural network training and results in a trained neural
network that has learned to detect the nuclei directly from the weakly exposed channel.

Training Data e.g. ( )
high SNR iMages sl ( _3/2:'(/ )
LGround Truth® 07y R N
A S )
\ N AN
XY R
( T )\\‘~-f v o
\‘ -, --“-‘(/ﬂ\/\//
Target Dat . N
arget Data e.g.
low SNR images scanR Al Training Trained Al model

(exchangeable file)

After this one-time training phase, it is no longer necessary to acquire well-exposed images. Instead, the
nuclei can directly be detected and measured from the weakly exposed channel, reducing the light ex-
posure and phototoxicity dramatically and saving acquisition time. The trained neural network can be
used on the same scanR system or exported and distributed to as many other scan® systems or analysis
workstations as required, enabling all of them to perform the same kind of analysis.
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’ Result e.g. probability image
for cell segmentation

Trained Al model @ :

scanR
Inference ’
Target Data, e.g.

low SNR images _'}

The general concept of self-learning microscopy can transfer information from one or multiple channels
acquired only during the training phase, i.e., while developing an assay, to another channel. Applications
range from previously impossible image segmentation tasks to quantitative analysis of shallow signal
levels, simplifying staining protocols, label-free analysis, and more. A straightforward application of label-
free analysis, for example, is the detection, counting, and measurement of nuclei in bright field images.

Training Data e.g.

Fluorescence Images _’
.Ground Truth* ():

Target Data e.g. _’
Transmission Images scanR Al Training Trained Al model
(exchangeable file)

Trained Al model @ } Result e.g. probability image

for cell segmentation

/.

ne0
(X 3 )
N4

scanR }
Interference

Target Data e.g.
Transmission Images —>

6.2 Training a neural network

A prerequisite for neural network training is a single or multiple analysis (.sca)-files containing detected
(main) objects. These detected objects serve as ground truth and provide examples of what the network
shall learn to detect from one or multiple color channels later. The analysis file(s) must also contain the
color channel(s) where the neural network shall work on later. During the training phase, the neural net-
work learns from these examples how to detect the objects on the target data.
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=8 Neural Network Training
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Main G1

Main G2
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Total data set size: 1 vIP Remove

Compatibility Status Ignore
Main: Unclear Nuclei Remove

Cancel

A new neural model is trained with the following steps.

1. Open the Neural Network Training wizard by Al » Neural Network Training.

2. Inthe Analyses section, add one or multiple analysis (.sca) files containing the training data.

3. Inthe Input Channels section, select the channel of the target data, i.e., the data the neural
network shall work on later.
Advanced:
Multiple channels can be selected together. All channels added to this list will be used for de-
tection later; hence all channels need to be acquired later for analysis. Often it is sufficient to
add only one channel to the list so that the neural network learns to work on a single channel.
If the input data contains z-stacks, more options are available:
Central slice: The in focus slice of the z-stack is used for training. This means the network
will not need z-stack data after training. The z-stack is only used during training to make the
trained model robust to possible slight defocus of images.
Pair of slices or Difference of slices: Two slices of the input z-stack are used for training .
This means, the network will need a z-stack with at least two slices to run on after the training.
Z-steps: Determines which two z-slices are used from a larger z-stack. The setting of Z-
steps=1 means the two slices next to the in-focus slice (+/-1) are used. The setting Z-steps=2
means the slices +/- 2 are used, and so on.
Scaling: Very large objects are better detected if the internal scaling is set to 50% or 25%.

4. As Classes to detect either all main objects (Main) or one or multiple gates can be selected
to include only objects of this particular gate or these gates.
Each class has a level assigned. Classes of the same level cannot overlap. If classes should
overlap (like subobjects and main objects), they should be set to different levels.
Each class can be defined as containing instances. Defining a class as instance makes the
training to learn how to separate individual nuclei or cells. Please note that the training data
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needs enough examples of well-separated objects .

Furthermore, a gate with objects to be ignored for the training can be provided. Use this Ig-
nore gate for objects that are not correctly detected in the training data but are not back-
ground. For example, partly detected nuclei or double detections (nuclei not correctly
separated in the training data) can be ignored.

5. On the next page of the wizard, the Training Configuration and the Number of Iterations
can be changed. The default “Standard Network” and 25,000 iterations are a good start for
most applications with a single class. However, networks with multiple classes or instance
segmentation require longer training times.

6. Now all required information is provided, and the training can be started.

Depending on the training configuration and the number of iterations, the training can take between a
couple of minutes and many hours. During this time, it is possible to follow the training progress by a
Quality graph and a selection of validation images generated for five checkpoints during the training.

As validation data, 10% of the total input images are set aside from the training and only used to control
(validate) the training results during the training already. One of the quality graphs and the preview re-
sults on the image data are only calculated on the validation images to ensure that the training is suc-
cessfully generalizing rather than only improving on the training data itself.

Any Checkpoint, except the initial Reference checkpoint, can be saved as Neural Network Model.
Judging the validation images for the different checkpoints makes it easy to select the best training re-
sult as the neural network model used in later analyses. The Final Checkpoint will often be the best
training result because it has trained for the longest time, but in special cases, the training result can be
better at an earlier training state.

6.3 Managing neural networks

Any neural network saved from any checkpoint will be added to an internal model database. It is possi-
ble to save neural network models as private, i.e. only visible to the current user, or as public, i.e. visi-
ble to all users. The neural network database can be maintained in the Al » Manage Neural Networks
dialog. Here, networks can be deleted, exported or imported. By exporting a network and importing it on
another system, it is possible to deploy established neural networks to many systems and run assays
based on these networks on other systems.

6.4 Standard detection workflow

A neural network model which has been trained for a single class is a detection network. It can be used
to segment foreground objects and separate them from the background. Section 3.9.3, Neural Network
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Processing, describes how to use a trained model in an assay to analyze new data. Basically, the neural
network model is used to create one or multiple new Virtual Channels. They contain segmented objects
and probability maps, meaning the probabilities per pixel that this pixel belongs to the foreground. The
probabilities are gray values (from 0 .. MAX') where O corresponds to a pixel where the network is very
sure that it is background and MAX where the network predicts foreground (or a particular class) with
maximal certainty. In other words, the probability maps give an overview of the confidence of the net-
work.

Any Virtual Channel containing segmented objects can be used directly in the Main Object step of as-
say setup.

Alternativly, a Virtual Channel containing a probability map can be used in combination with an Intensi-
ty-based Object Finder similar to the definition of objects in any other kind of channel. Typically, a value
for a threshold of about ~50% probability is used to detect all object pixels where the network predicts
higher probability of foreground than background. The value can be decreased (for example ~= 25%) to
also include pixels with lower confidence or increased (for example ~= 75%) to only include pixels with
very high confidence.

The object masks derived from the Virtual Channel can be used just like any other object masks in
scan®. In particular, they can be used for measuring all kinds of parameters as described in Chapter 3.6,
Measurement parameters, including geometrical parameters of the objects (like area, circularity) and
intensity parameters (like mean intensity in any fluorescence channel).

Of particular interest is the parameter mean Intensity of the probability channel itself. When this param-

eter is defined for analysis, it can be used in histograms for directed investigation on those objects

where the network has only lower confidence. If the network should have false detections, these typical-

ly happen with lower confidence, and investigation of these potentially problematic detections can

strengthen trust in the network and help to understand its capabilities and limitations thoroughly.
]

Remowve
Zoom to

Gate

kRegion Gallery

II_ZILIZI B00.0 1000.01500 00 0.0 40950
e
For example, it is straightforward to inspect galleries of objects with the lowest 0.5% of confidence (left)
and understand the reasons the neural network is less confident than with the other objects (right). Typi-
cally the reason is that those objects are not very typical and leave room for uncertainty for both, the
human expert and the neural network.

1 The value of MAX depends on the assay bit depth (16 bit or 12 bit). For 16-bit assays it is MAX = 65,535 = 100% and for
12-bit assays it is MAX = 4095 = 100%.
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This also opens an easy way of optimizing an analysis towards a higher sensitivity (including more
objects even if they are less certainly of the correct class) or towards a higher specificity (include only
objects with very high confidence that they are of the correct class). For this purpose, a gate can be
created on the histogram of the mean Intensity of the probability channel and set for higher or lower
values.

6.5 Standard classification workflow

While a network trained for a single class detection creates only one pair of Virtual Channels, which
describes all results for this class (i.e. objects and probabilities), a network trained for multiple classes
creates a set of Virtual Channels with different results.

The first Virtual Channel (default name: All Objects) contains all objects of all classes. This channel can
be used directly for the definition of all objects as Main Objects or Sub-objects.

Then, there is one pair of Virtual Channel fors each class. These contain the objects of the class and the
probability maps which give the probability for the particular class. It can be used for detection and seg-
mentation of objects of individual classes.

The last Virtual Channel is the Classification itself. It encodes for each pixel to which class it most likely
belongs. There are special parameters available in the Assay — Parameters tab to work on the classifi-
cation Virtual Channel and derive the object classification for the analysis.

6.5.1 Example for cell cycle analysis

In this example, a neural network has been trained to detect and classify mitotic and non-mitotic nuclei
from bright-field images. The network creates six Virtual Channels:
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The All Objects channel is used to detect all objects directly.
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The following parameters are defined in Assay Setting — Parameters:

g7 | Mean Intensity

Mitotic Probability

Main

p2 | Mean Intensity

Mon-Mitatic Probabilit

hain

p9 | Most Frequent Class

Classification

Main

p10 | Entropy

Classification

Main

The most straightforward way to create a simple classification is done by using the Most frequent class
parameter on the Classification channel. The corresponding histogram (left) shows all objects with
class = 1 (non-mitotic cells) and class = 2 (mitotic cells). It is now easy to gate for one or the other or
both classes for further analysis.

04 06 08 1.0 1.2 14 16 1.1

Entropy is an advanced parameter that describes the distribution of different classifications for different
pixels within an object. A value of entropy near 0 means that the vast majority of pixels within a particular
object share the same class while higher values mean that there are different classes within one object.
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By investigating objects with high entropy, the reasons for classification uncertainties can be better un-
derstood. Gating on objects with lower entropy increases specificity, while including objects with higher
entropy increases sensitivity.
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7 Appendix
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7.1.1 File conversion

scan® Analysis is able to analyze image data acquired with a third party imaging system as long as the
data are stored as (monochromatic) 16-bit single TIFF images. The file names must allow the assign-
ment of the images to individual positions, time stamps and color channels.

The command Scan » Custom conversion opens the Custom Conversion dialog that allows setting
up conversion rules. The creation of conversion rules is a four-step process, which will be described, in
the following chapters.

Save rule. This function saves the current conversion settings as a Custom Pattern file (*.cr).

Load rule. This function allows loading a stored set of conversion settings.

7.1.2 Images list

Root directory for image list generation. Click on the folder button on the right of the box to open the
navigation window. Navigate into the storage directory and click Select Curr. Dir.

Source image type. Select the correct image type (TIFF, JPEG, PNG or BMP) from the drop-down list.

B Custom Conversion X
ImagesList  Image Channel Definition ~ Scan Settings ~ View Conversion Results
Root directory for image list generation
=3
Source image type File extension
TIFF e i Retrieve image list
Full file paths
~
v
< >
Color Images Resolution Scale
1 - [ Convert 16 te 12 Bits
Save Rule Load Rule
Cancel OK




R
SC3N ™ Analysis Software Manual Chapter 7 — Appendix

File extension. This is set automatically when the Source image type is chosen. The file extension
serves to filter the content of the selected directory

Retrieve image list. This function reads the matching files into the Full file paths list. The arrow but-
tons allow easy browsing and verification of retrieved image data.

7.1.3 Image channel definition

If the file names of the third party images contain codes for Well, Position, Z-layer and Time, scan® will
sort them automatically upon conversion into scan® format. The Image Channel Definition tab is used
to define the conversion rules for this.

Unique Channel Identification String. If the original file names contain a certain expression — or Iden-
tification String — that classifies them as belonging to a certain color channel, enter it here.

Channel Name. Enter the Channel Name to be used in scan® here.
New. Click here to add the newly defined channel to the Image Channel list.

Well, Position, Slide (Z), Time RegExp. If the file names contain information about Well, Position, Z-
layer and Time in form of regular expressions (RegExp), scan® can group them when the corresponding
code is entered here.

An overview of the syntax of regular expressions can be found under
http://www.regular-expressions.info/tutorial.html.

EZ Custom Conversion X
Images List  Image Channel Definition  Scan Settings ~ View Conversion Results
Strings preceeding numerical values
Unique channel identification substring
00000--Cy3
Well
Channel name w
Cy3 Paosition
P
Color channels
-
DAPI [tz -
O L
Remove Time
T
Comment initiator
v
Comment terminator
Save Rule Load Rule
Cancel oK

117



118

Chapter 7 — Appendix OLYMPUS

Comment RegExp Initiator / Terminator. If the file names contain information about wells, scan® can
use this as Well Description, see for example Chapter 2.7, Interactive plate result view. Enter the first
(Initiator) and last (Terminator) alphanumerical digit(s) in the respective boxes.

7.1.4  Scan settings

Scan settings are used to reconstruct a minimal configuration file for the data conversion. scan® needs
information about the used multi-well plate and the arrangement of the images within the single wells in
order to represent the data properly in the graphical user interface

Result Dir. Click on the folder button on the right of the box to open the navigation window. Navigate to
the storage directory and click Select Curr. Dir.

Positions: Columns/Well and Rows/Well. Set the number of image columns and rows, respectively,
per well.

Wells: Columns and Rows. Set the number of columns and rows, respectively, of the multi well plate.

Time-lapse cycles. Set the number of time points for this scan.

@ Custom Conversion >

Images List  Image Channel Definition ~ 5can Settings  View Conversion Results

Result directory

ChConvertedScan =
Paositions Wells Scan
Columns/Well Columns Time-lapse cycles
2 = 12 = 1 S
Rows,/Well Rows 7 layers
3 > 8 < 1 3

Step width [pm]

1 =

Save Rule Load Rule

Cancel OK
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7.1.5 View conversion results

Test. Upon clicking this button, scan® converts the file names and lists them in the New File Name list.
This allows checking whether the conversion rules yield the desired result.

Start. Click here to start the file conversion process. The Start button becomes active once a conversion
rule is defined or loaded. It initiates the file conversion. This may be time consuming because an entire
new set of images is generated and stored.

ﬁ Custom Conversion X
Images List  Image Channel Definition ~ Scan Settings ~ View Conversion Results

Mew file names
~
v

< >

Save Rule Load Rule Test Start
Cancel OK

7.2 Reassign wells

In some cases, especially for histological samples, it may be of interest to define special regions within
one well (e.g. tumor and healthy tissue). The regions to be analyzed can be defined in the Reassign
Wells window. To open this window, go to Scan » Reassign Wells.... On the left side of the dialog the
image of the currently selected well will be displayed.
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Original well
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Press +Ctrl to add a new Region

To change the well that is displayed on the left, select another well in the Original Well drop-down list.
To navigate in the well image use the Zoom and Move mouse tools. Use the polygon tool to create a
polygon around the region of interest, and close the polygon with a double-click. A new region will ap-
pear in the Region list. The default name is W1R1 (Well 1, Region 1). You can enter a meaningful
name in the Region Name field instead. It is possible to assign the same name to two regions in order
to group these regions.

To create further regions use the polygon tool and press the Ctrl key on the keyboard at the same time.
Otherwise the first region will be replaced by the new region. With the Selection tool, the nodes of the
existing regions can be displaced (indicated by a double arrow cursor) or the whole region can be
moved (indicated by the crossed arrow cursor).

If more than one region is created and some of the regions are overlapping, you can choose the Region
Overlay Mode:

e Order Independent: The overlapping area will not be cut. The complete area inside a defined
region belongs to this region. Overlapping areas will belong to two regions.

e Cut by Order: The overlapping area of a region further down the Region List will be cut from
the higher region. By this, doughnut-like regions can be defined.
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IR Rl

Order Independent

Cut by Order

The Cut by Order mode depends on the order of the regions in the Region List. To change the order of
the regions, mark the region to be moved in the Region List and use the arrow icons to move this re-
gion up or down in the list. The region that is lower in the list will cut the overlapping area from the region
that is higher in the list.

Cut by Order W1R1 above W1R2

Cut by Order W1R2 above W1R1
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The new “virtual” wells that are defined in the Reassign Well dialog will fully replace the original wells in
the analysis. This means they replace the original wells in the Assay Settings dialogs (see Chapter 3,
Assays ), the front panel and the Well Results (see Chapter 4.4 Well results).

7.3 FCS export functionality

scan® is able to export single cell data to ISAC FCS 3.0 Standard files. Please note, that this standard is
not fully implemented by most of the programs that specify FCS 3.0 import support. Therefore some
settings modifications for export might be necessary depending on the specific limitations of these pro-
grams. In practice especially the FCS 3.0 requirements for double and integer 32 bit data support as well
as multi dataset FCS files might not be implemented because most flow cytometers produce integer 16
bit data in single data sets. It is therefore recommended to test the FCS 3.0 compatibility before deciding
which FCS program is to be used for the analysis. Most manufactures provide demo programs for test-

ing.

In order to export FCS data open the Preferences dialog from the menu bar.

Data Export
Scale Export Export Min Export Max Clipping %
Export2Tut Scoled 10 5 B4000 |5 0 5
7T cale
[#] FCS Analysis Export Wells Export Data Type
Merge Well Data ~ Integer 32 w

Export Data Type. Here you can choose the data types exported (Integer 16 / Integer 32 / double (64-
bit floating point) according to FCS 3.0 standard. It is recommended to use the highest precision that is
supported by the program intended to import the fcs files.

Scale Export Scaled (On/Off). This button activates the rescaling procedures during FCS export.
Switch off the scaling if you want to compare datasets from two separate export procedures quantitative-
ly. If activated, the scaling settings (Min/Max/Clipping) will be used.

Export Min / Export Max / Clipping %. Settings used for rescaling the original data according to:

x_fcs = x*PnG + PnOffset, with:

x_fcs exported data points

X the original data points and

n parameter number

PnG automatically determined linear scaling factor (Gain)
PnOffset automatically determined scaling offset

The resulting scaling offset and the scaling factor are stored in the FCS file header in the keywords PnG
and PnOffset. If you switch on the scaling then the range of the original data will be scaled to fit into the
given export range. PnG and PnOffest are calculated from the original dataset and the scale settings
according to:
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Export Range = Export Max - Export Min
Original Data Range = Original Data Set Max Value - Original Data Set Min Value

Clipped Range = Original Data Set Max Value (ignoring the largest clip %) - Original Data Set Min
Value (ignoring the smallest clip %)

PnG = Export Range/Clipped Range

PnOffset = Export Min - PnG*(Original Data Set Min Value (ignoring the smallest clip %))
Analysis Export Wells (FCS Settings):

Merge Well Data. All Wells are taken together to a single dataset

Single File. Exports Wells into separate datasets in a single FCS file according to FCS 3.0 standard
(this Multi-dataset format is not supported by all FCS programs)

Separate Files. The export table function creates a single FCS file for every well.

i16 export (FlowJo™). When using i16 export and importing with FlowJo™, FlowJo™ uses
the gain to rescale the data but is then not able to go back to the logscale. Therefore it is
recommended to use raw mode with i16 and FlowJo™. To switch to logscale use then the
FlowJo™ function: Add derived ... and convert the required parameters to log. Doubles and
Multi-dataset FCS Files cannot be read by FlowJo™. Please note, that if you have data with-
in a X,Y logscale and you rescale the X,Y data with different scaling factors (as might hap-
pen with the automated scaling during export because of range differences) there might be
a shape change.

An alternative to FlowJo is FCS Express™ (http://www.denovosoftware.com).
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7.4 Libraries

7.4.1  Object analyzers library (OAL)

B object & x
s
Parameter Name 0A Module OA Parameter Narne ~
Total Intensity 2 D Mean.vi Total Intensity Module Location
Mean Intensity 2D Meanwi Mean Intensity C:\Program Files\scanR_Package_28RC1\Analysis\Object =
Max Intensity 2D Mean.vi Maximum Intensity
Min Intensity 2D Mean.vi Minimum Intensity Object Analyser Module
A.raa 2D Geoms.vi Area i i Total Intensity
Circularity Factor 2D Geoms.vi Heywood Circularity Factar
Perimeter 2D Geoms.vi Perimeter
Max Feret Diameter 2D Geoms.vi Max Feret Diameter FETETTa
Elongation Factor 2D Geoms.vi Elengation Factor Total Intensity v

New Remove

o Cancel oK

The password-protected Object Analyzers Library can be accessed through Modules » Object Ana-
lyzers Library.

It allows managing the set of parameters selectable in the Edit Assay tab Parameters; see Chapter
4.6, Measurement Parameters.
Add. Click here to add a new entry to the list.

Parameter. Select the desired parameter from the drop-down list to add it to the list.

7.4.2  Object finders library (OFL)

The password protected Object Finders Library can be accessed through Modules » Object Finders

Library. It lists and allows administrating the available Object Finder Modules. Each module may have
different settings lists and may thus appear several times.
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EZ Object Finders

Settings Name Object Finder Module Module Name
FullFrame Fulllmage.vi Image Module Location
ModuleDefault EdgeSegmentation2.vi Edge C:\Program Files\scanR_Package_28RCT\Analysis\Object =
Default Standard01.vi Intensity
All Standard01.vi Intensity Settings
FullFrame

Object Finder Module

Image

MNew

Cancel OK

Add/Remove. Click here to add or delete a new entry to the list.

7.4.3

Image processing library

The password-protected Image Processing Library can be accessed through Modules » Image Pro-

cessors...

It allows managing the set of available Image Processing algorithms in the Image Processing mod-

ules.

Add Module. Click here to add a new entry to the list.

Remove Module. Click here remove an entry from the list.

ﬁ Image Processing Library

Image Processing Modules

Module Name Module
RellingBallD2.vi
KYShi ImageXYShift.vi
Inversion Inversion.vi
Cutlmage Cutlmagewi
Absorbanceln Absorbancelnwvi
Smeothing Smoothlmagel.vi

Shading Correction

ShadingCorrection.vi

Smeothing (Median)

Smoothlmage_Median.vi

2D Deconvelution

2dDeconvolution.vi

3D Deconvolution

3dDecenvolution.vi

Module Location

C:\Pregram Files\scanR_Package_28RC1\Analysis\image || (=

Module Name

BackgroundCorrection

Add Remove

oK
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7.4.4  Virtual channel library

@ Virtual Channel Library X
Virtual Channel Modules
Meodule Name Module A
Simple Math SimpleArithreticsD1.vi Module Location
SpectralUnmixing LinearUnmixing3indout.vi C:\Program Files\scanR_Package_28RC1\Analysis\image || (=
Module Name
Simple Math
Add Remove
v Cancel OK

The password-protected Virtual Channel Library can be accessed through Modules » VC Proces-
Sors...

It allows managing the set of available Virtual Channel algorithms in the module selector on the Edit
Assay » Virtual Channels tab.

Add Module. Click here to add a new entry to the list.

Remove Module. Click here remove an entry from the list.
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7.5 Valid functions for derived parameters

abs(x)
acos(x)
acosh(x)
asin(x)
asinh(x)
atan(x)
atanh(x)
ceil(x)
ci(x)
cos(x)
cosh(x)
cot(x)
csc(x)
exp(x)
expmi(x)
floor(x)
getexp(x)
gamma(x)
getman(x)
int(x)
intrz(x)
In(x)
Inp1(x)
log(x)
log2(x)
rand()
si(x)
sec(X)

sign(x)

sin(x)
sinc(x)
sinh(x)
spike(x)
sqrt(x)
step(x)
tan(x)

tanh(x)

Absolute Value

Inverse Cosine

Inverse Hyperbolic Cosine
Inverse Sine

Inverse Hyperbolic Sine
Inverse Tangent

Inverse Hyperbolic Tangent
Round Toward +Infinity
Cosine Integral

Cosine

Hyperbolic Cosine
Cotangent

Cosecant

Exponential

Exponential (Arg) — 1
Round To —Infinity
Mantissa & Exponent
Gamma

Mantissa & Exponent
Round To Nearest
Natural Logarithm

Natural Logarithm (Arg +1)
Logarithm Base 10
Logarithm Base 2
Random Number (0 — 1)
Sine Integral

Secant

Sign

Sine

Sinc

Hyperbolic Sine
Spike

Square Root
Step

Tangent

Hyperbolic Tangent

Returns the absolute value of x.

Computes the inverse cosine of x in radians.

Computes the inverse hyperbolic cosine of x.

Computes the inverse sine of x in radians.

Computes the inverse hyperbolic sine of x.

Computes the inverse tangent of x in radians.

Computes the inverse hyperbolic tangent of x.

Rounds x to the next higher integer (smallest integer >= x).
Evaluates the cosine integral for any real nonnegative number x.
Computes the cosine of X, where x is in radians.

Computes the hyperbolic cosine of x.

Computes the cotangent of x (1/tan(x)), where x is in radians.
Computes the cosecant of x (1/sin(x)), where x is in radians.
Computes the value of e raised to the x power.

Computes one less than the value of e raised to the x power ((e”x) — 1).
Truncates x to the next lower integer (largest integer <= x).
Returns the exponent of x.

Evaluates the gamma function or incomplete gamma function for x.
Returns the mantissa of x.

Rounds x to the nearest integer.

Rounds x to the nearest integer between x and zero.

Computes the natural logarithm of x (to the base of e).
Computes the natural logarithm of (x + 1).

Computes the logarithm of x (to the base of 10).

Computes the logarithm of x (to the base of 2).

Produces a floating-point number between 0 and 1 exclusively.
Evaluates the sine integral for any real number x.

Computes the secant of x, where x is in radians (1/cos(x)).

Returns 1 if x is greater than 0, returns 0 if x is equal to 0, and returns -1 if x
is less than 0.

Computes the sine of x, where x is in radians.

Computes the sine of x divided by x (sin(x)/x), where X is in radians.
Computes the hyperbolic sine of x.

Generates the spike function for any real number x.

Computes the square root of x.

Generates the step function for any real number x.

Computes the tangent of x, where X is in radians.

Computes the hyperbolic tangent of x.
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7.6 Export to imaging software

In various scenarios it is desirable to have a closer look at individual cells or cells which are gated for
particular properties. For this purpose, scan® supports the export of all object positions of any defined
gate into position lists that can be used in the Olympus cellSens and xcellence high-end imaging soft-
ware, respectively.

7.6.1  Setting up the export to xcellence functionality

In the preferences (see Chapter 2.2 Preferences), the export to imaging software functionality can be
enabled by checking the corresponding option. Before the export can be used for the first time, scan®
initially needs the full path to the OBSPOSLISTS.XML file, the xcellence database of position lists. For
typical installations the file is located at C:\Users\All Users\Olympus\OSIS\xcellence rt.

7.6.2  Setting up the export to cellSens functionality

In the preferences (see Chapter 2.2 Preferences), the export to imaging software functionality can be
enabled by checking the corresponding option. Before the export can be used for the first time, scan®
needs to be connected to cellSens by selecting “Configure”.

7.6.3 Exporting the positions of gated objects

When the export to imaging software functionality is enabled, the Gate Manager (see Chapter 4.2.2)
reveals an additional button, labeled as Export to xcellence or Export to cellSens, respectively.
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0 Assay Gating

Regions Edit Gate
RO1
RO2 Name
R0O3
R0O4
RO5

Color

Long Traces

Definition

Remove

Gate application

Gates

Name Definition
RO1

Long Traces

Histogram | Gate Name Count Tot.%  |xMean  [xSTDV  [«CV% |[yMean [ySIDV [yCV% |
Hi 936 100. 54 NaN

None
None
Long Traces
None

Remove

.0 2.8E+1 43E+1

100.0 1.56+1 29E+1

107 B T9E+1
44E+1 2
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22E+0
1.1E+3
0.0E+0

0.0E+0

1.8E+0 848
3.6E+1 EX)
0.0E+0 EL
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Well Results

Applied gate

None o

Gallery

Export Data

Edit Regions.

In order to export the positions of all objects within a particular gate, simply select the gate in the list left
to the button and press the button. In the following dialog, a suggestion for the name of the position list

in xcellence/cellSens is presented,

which can be edited if necessary.

ﬁ Position Bxport

Mame of experted position list
scanR-CMV-mRed+cyclineB1-GFP-Muclei

OK Cancel

X

Pressing the OK button finished the export process and the newly created positions list can be used
immediately in xcellence or opened in cellSens by the usual steps.
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